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5Introduction

1 Introduction

The  following topics are intended to provide you with an insight into what is available in
the Reporting and Analysis area of Ostendo and give you a guide as to how you can
achieve your required results
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2 Report and View Developer

Ostendo's Report and View Developer allows you to create and/or amend Reports, Analysis
Views, Charts, and Pivot Views within Ostendo and include these in the Ostendo Menu structure.

The steps taken when generating a new Report, View, Chart, or Pivot are as follows:
· Define the Style of the output and where it is to appear in the Menu Structure
· Define the Data to be extracted to produce the output
· Define the Parameters to be used when running the report
· Create the Report, View, Chart, or Pivot output format

In generating a new Report or View, or copying an existing one, you should note:

· System Reports and Views Ostendo contains a base folder of reports that are held
under Ostendo sub-folder ‘Reports’.  These reports and views are maintained and updated
by Development-X and cannot be amended by the end user.

· Customer Reports and Views An Ostendo user can create their own Report or View by
either (a) Creating a new Report (or View) ‘from scratch’, or (b) Copying a ‘System’ level
Report or View and amending it as required.  In both cases the new report or view will be
created and held in an Ostendo sub-folder whose name will be the current signed on
Company.

· Reporting Priority Whenever the Report or View is called in normal ‘day-to-day’ activity
Ostendo will first look into the ‘Company’ folder to get the document.  If it does not exist in
that folder then the base Ostendo Report or View will be used.

The Report and View Developer is accessed via File>Reporting Configuration and comprises of
three screens

· List Screen
· Master Settings Screen
· Detail Query Screen

2.1 List Screen

The displayed fields are taken from the Report or View record previously generated via the Master
Settings Screen

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Displayed Fields
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Category - The Category to which the Report belongs as entered in the ‘Master Settings’ tab.

Level - The entry Level at which the Report was created.  The options are:
System: Reports generated by Development-X. 
Company: Reports generated by the end user.  ‘System’ level reports can be copied and
saved as ‘Company’ Level reports.  Company Level Reports take priority over a System
Level report if it has the same Report Name

Name: Display only field showing the name of the Report, Analysis, Chart, or Pivot View

Type: Display only field showing the Type of Output.  The displayed variants are:
Report
Analysis
Chart
Pivot View
Inquiry
Edit View

Menu Order: Display only field showing the sequence number that dictates where this Report will
appear in a drop-down list

Master SQL: Display only field showing main data extraction criteria using an SQL Query
(Structured Query Language) Statement as entered into the ‘Master Settings’ tab

Buttons

Close: This will close the Reports and Views Developer screen. 

Add: This will bring up a panel for defining the new Report, Analysis, Chart, or Pivot View.  You
can create a new report ‘from scratch’ or copy an existing format.  In either case it will create an
output who's ‘Level’ will be preset at ‘Company’.  On this panel the following fields are available.

Create from Scratch: Select this Radio Button if you are going to generate the Report,
Analysis, Chart, or Pivot View from scratch.  The following two fields will be presented
which must be completed

Type: Select the Radio Button that represents the type of view being created.  The
options are:

Report
Analysis
Chart
Pivot View
Inquiry
Edit View

Name: Enter the Name of the view.  Duplicate Names are not allowed
Copy from Another: Select this Radio Button if you are going to generate the Report,
Analysis, Chart, or Pivot View by copying an existing view and using that as a start point. 
The following options are now presented

Output to be copied: From the drop-down list select the current Report, Analysis,
Chart, or Pivot View that will form the basis of the new report or view.  When
selecting this option you can define what will happen to the copied view as follows:
Copy to Company: Select this Radio Button to denote that the above  ‘Output to
be Copied’ document will replace and existing document of the same name in the
‘Company’ Reports folder
Add New to Company: Select this Radio Button to denote that the above ‘Output
to be Copied’ document will be used as the basis for creating a new report or view.
The name of the new should be entered into the next field
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Name: Mandatory entry if the ‘Be an Additional’ Radio Button has been selected.
Duplicate Names are not allowed

Save: Not applicable to the List View

Cancel: Not applicable to the List View

Delete: This removes the current Report, View, Chart, or Pivot from this table

2.2 Master Settings Screen

This screen is split into three sections:
· Definition: This allows you to define the specific attributes to the Report, View, Chart, or

Pivot document. 
· Master Query:  This contains the master query that relates to the extracted data
· Conditions:  Allows you to define any parameters to be used

Section 1 - Definition

The fields in this sections will vary depending upon the Type of report being generated

Reports

Include in Main Menu: ‘Check’ this checkbox if the Report is to appear in the ‘Reports’ section in
the Main Menu.  If this is checked then an entry is required in field ‘Category’ to denote under
which Main Menu Toolbar Category the Report is to appear.

Name: A mandatory entry where you should specify the name of the report.  This is the name that
will appear in the Menu drop-down lists.  Duplicate entries of the same name are not allowed.  You
should note that if the Report Type selection (below) is ‘Form’ then the selection must come from
the drop-down list.

Menu Order: Enter a sequence number that dictates where this Report will appear in the
drop-down list in both the Main Menu and the Specific Screen.  No checks are made against this
entry and duplicates will not be rejected.

Category: This is a mandatory selection in which you should select the Main Menu Category
under which this report will appear.  

Report Type: You should note that if you select ‘Form’ then Ostendo needs to know the specific
Form being referenced.   Therefore, whenever the Report Type is ‘Form’ you are restricted to the
options available under the drop-down shown under field ‘Name’.  For example if you select ‘
Invoice’ then Ostendo knows what information is provided ‘behind the scenes’ to support this
specific Form. 

If you require to have more than one output style for a Form then you would use this same
selection criteria but, in the Form Edit screen, ‘save the alternative Form under a different name.
You can then specify when this alternate report is to be used in screen File>Report and View
Developer>Specific Form Layouts.  This methodology allows you to have many Report formats
using the same basic extraction criteria

Specific Screen: An optional entry field where you can select a specific screen from the
drop-down list.  This informs Ostendo that, when in this specific screen, the ‘Reports’ button will
contain this Report in the drop-down list
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Report Filename: The Report will be added to Ostendo’s list of reports using the name supplied
here.  The name should be unique and comprise of Alphas and/or Numerics with no spaces. 
Ostendo will allocate it an extension of .frf

Archive: If you wish to archive this document at the same time as it is printed then 'Check' this
checkbox.  The archived document that then be recalled and reprinted via File>Archive Viewer

Archive Prefix: You can define the format of the archived document name.  This can be a
combination of plain text and fields taken from the Master Query (see below).  For example if this
was a Sales Invoice you may wish to name the archived document 'Invoice - INV1234' where the
word Invoice is open format text and INV1234 is the actual Invoice number
Therefore the entry in this field will be Invoice - [INVOICENUMBER].   Note: the Master Query field
is enclosed in 'Square Brackets'

Archive Folder Name: enter a Folder name under which this archived document will be located.
If this folder does not currently exist under Ostendo>Archive Files then it will be created.

Views

Include in Main Menu: ‘Check’ this checkbox if the View is to appear in the ‘Views’ section in the
Main Menu.  If this is checked then an entry is required in field ‘Category’ to denote under which
Main Menu Toolbar Category the View is to appear.

Name: A mandatory entry where you should specify the name of the View.  This is the name that
will appear in the Menu drop-down lists.  Duplicate entries of the same name are not allowed. 

Menu Order: Enter a sequence number that dictates where this View will appear in the drop-down
list in both the Main Menu and the Specific Screen.  No checks are made against this entry and
duplicates will not be rejected.

Category: This is a mandatory selection in which you should select the Main Menu Category
under which this View will appear.  

Master Key Field: If you wish to display the View into groups (Example: All BOM Components
within a Parent Item) then you should identify the Key field by which the grouping is to be made 

Detail Key Field: If you wish to display the View into Sub-Groups within the above Master Key
Group then you should identify the Detail Key field by which the sub-grouping is to be made 

Title:  Enter a short name for the Analysis View.  This will appear as a title to the View whenever it
is run.  No checks are made on the entry

Charts

Include in Main Menu: ‘Check’ this checkbox if the Chart is to appear in the ‘Views’ section in the
Main Menu.  If this is checked then an entry is required in field ‘Category’ to denote under which
Main Menu Toolbar Category the Chart is to appear.

Name: A mandatory entry where you should specify the name of the Chart.  This is the name that
will appear in the Menu drop-down lists.  Duplicate entries of the same name are not allowed. 

Menu Order: Enter a sequence number that dictates where this Chart will appear in the
drop-down list in both the Main Menu and the Specific Screen.  No checks are made against this
entry and duplicates will not be rejected.

Category: This is a mandatory selection in which you should select the Main Menu Category
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under which this Chart will appear.  

Title:  Enter a short name for the Chart.  This will appear as a title to the Chart whenever it is run.
No checks are made on the entry

Pivots

Include in Main Menu: ‘Check’ this checkbox if the Pivot View is to appear in the ‘Views’ section
in the Main Menu.  If this is checked then an entry is required in field ‘Category’ to denote under
which Main Menu Toolbar Category the Pivot View is to appear.

Name: A mandatory entry where you should specify the name of the Pivot View.  This is the name
that will appear in the Menu drop-down lists.  Duplicate entries of the same name are not allowed. 

Menu Order: Enter a sequence number that dictates where this Pivot View will appear in the
drop-down list in both the Main Menu and the Specific Screen.  No checks are made against this
entry and duplicates will not be rejected.

Category: This is a mandatory selection in which you should select the Main Menu Category
under which this Pivot View will appear.  

Title:  Enter a short name for the Pivot View.  This will appear as a title to the Pivot View whenever
it is run.  No checks are made on the entry

Inquiry Screens

Include in Main Menu: ‘Check’ this checkbox if the Inquiry Screen is to appear in the ‘Inquiry’
section in the Main Menu.  If this is checked then an entry is required in field ‘Category’ to denote
under which Main Menu Toolbar Category the Inquiry Screen is to appear.

Name: A mandatory entry where you should specify the name of the Inquiry Screen.  This is the
name that will appear in the Menu drop-down lists.  Duplicate entries of the same name are not
allowed. 

Menu Order: Enter a sequence number that dictates where this Inquiry Screen will appear in the
drop-down list in both the Main Menu and the Specific Screen.  No checks are made against this
entry and duplicates will not be rejected.

Category: This is a mandatory selection in which you should select the Main Menu Category
under which this Inquiry Screen will appear.  

Title:  Enter a short name for the Inquiry Screen.  This will appear as a title to the Inquiry Screen
whenever it is run.  No checks are made on the entry

Section 2 - Master Query

This is a mandatory entry and allows you to define the main data extraction criteria using an SQL
Query (Structured Query Language) Statement.  SQL Statements can range from simple to
complex.  For instructions on SQL refer to the SQL Section in this Help Guide.

To generate your Query you can either key your Query directly in to this field or click on the ‘SQL
Builder’ Button.  This will bring a separate panel in which you have help in creating the query.  On
the displayed screen there are three panels

Tables - The names of all the Tables (database files) that are used by Ostendo
Fields - Having selected a specific Table this will show each field in that Table
Query - This is where you create and maintain the query as described below
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You can enter a query in one of two ways
§ Type in directly
§ Create using ‘prompts’

To create using ‘prompts’ you can copy:-
§ Tables to the Query by selecting the table and either double clicking the left mouse

or clicking on the ‘Add Table to Query’ button
§ Fields to the Query by first selecting the correct Table then the field and either

double clicking the left mouse or clicking on the ‘Add Field to Query’ button
§ Keywords to the Query by clicking the ‘Options’ button and selecting ‘Add Keyword’

and then selecting the appropriate keyword.    Available Keywords are Select, *,
Sum, Count, From, Where

§ Operators to the Query by clicking the ‘Options’ button and selecting ‘Add Operator’
and then selecting the appropriate Operator.   Available Operators are >, <, =. <>,
+, -, /

SysUniqueID and GridUniqueIndex

For Views, Pivots, Charts and Inquiries Ostendo needs to know what field is to be used as the
primary - unique - index so that it can display the records.  For this reason it is recommended
that you use SysUniqueID as this a unique reference held against each record in Ostendo.   
However, where you are extracting from more than one Table then you are required to specify
the specific SysUniqueID as follows

· Where the selection criteria is from a single Table and is of the format Select * from .....etc
then there is only one SysUniqueId field selected per record and therefore Ostendo knows
the unique reference which means that you need not specify this.

· Where the selection criteria is from a single Table and is of the format Select Itemcode,
ItemDescription from ItemMaster then there is no SysUniqueId field in the selection criteria
therefore it must be added.  For example:  Select Itemcode, ItemDescription, SysUniqueID
from ItemMaster.

· Where the selection criteria is from two Tables and then you need to specify from which
Table the SysUniqueID comes from.  For example if you select from the Item Master and
wish to show all Units Of Measure then the extraction query would be  Select
Itemmaster.ItemCode as "Item_Code", Itemmaster.ItemDescription as "Description",
ItemUnits.ToUnit as “To_Unit”,  Itemmaster.sysuniqueid as griduniqueindex from
ItemMaster,ItemUnits where Itemmaster.itemcode = itemunits.itemcode

Colour Displayed Fields in Inquiry Views

· The Tracking Codes defined under Assembly, Purchase, Sales and Job settings allow you
to associate a colour code with the Tracking status.  You can display this colour in an Inquiry
View by using the following format

                         “DISPLAYCOLOUR_TrackingStatus” 

For example, If the Tracking Code was called "Treatment' then the defined field would be 
“DISPLAYCOLOUR_Treatment” 

Section 3 - Master Query Conditions

This panel allows you to define selection criteria for use against that SQL.  These will be displayed
as parameter entry fields when running the Report, View, Chart, or Pivot.
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There are six basic types of Conditions:
· Selection(s) from an Ostendo Table (Example: Job Order Number)
· Manual entry against which to compare data (Example: Date, entered text, etc)
· Condition(s) selected from pre-defined variables (Domains)
· Boolean Condition select (‘Yes’ or ‘No’)
· Multiple Select Options (Example: Select A,C and F from a list of A,B,C,D,E, and F)
· Select from any Table in Ostendo including User-Defined Tables

These conditions can be used as selection criteria to be made against both the Master Query and
nominated Detail Queries.  Examples are given below to show how you can apply conditions to the
Master Query.   For applying Conditions to Detail Queries see Section 4.

Condition 1 - Field Value Lookup

This Condition allows you to interrogate an Ostendo Table and select a specific value.  The format
of this type of parameter is DisplayName;Condition linked to a Condition Index where:

DisplayName is the text that you wish to appear on the parameter entry screen
Condition has three elements

Field Name: The specific field within the Table identified within the Master SQL
and ‘Condition Index’
Operator: The specific Operator that you wish to apply to this parameter.  The
Available Operators are >, <, =, <>, >=, <=
Identifier: Enter a unique identifier that you are assigning to this parameter.  For
example: if the parameter is the start range of Job Numbers then this could be
given an Identifier of ‘JobFrom’

Condition Index refers to the Table that contains the above Field Value.  Click on the
drop-down against field ‘Condition Indexes’ and select an Index in the 1000 range.  

Example for use against the Master Query: If you are creating a Job Orders Report then the
Master SQL will refer to the Table JOBHEADER.  This parameter represents the start range of
selected Job Numbers and will show - in a drop-down list - all Job Orders currently in Ostendo.  In
this instance the parameter could be:

Conditions: Job Order From;ORDERNUMBER>= :JOBFROM 
Condition Index: 1075 (Job Orders)

Condition 2 - Free Format Entry

This format allows the user to enter a specific value against a parameter.  The format of this type
of parameter is DisplayName;Condition linked to a Condition Index where:

DisplayName is the text that you wish to appear on the parameter entry screen
Condition has three elements

Field Name: The specific field within the Table identified in the Master SQL
Operator: The specific Operator that you wish to apply to this parameter.  The
Available Operators are >, <, =, <>, >=, <=
Identifier: Enter a unique identifier that you are assigning to this parameter.  For
example: if the parameter is the start date of a range of Job Orders then this could
be given an Identifier of ‘DateFrom’

Condition Index refers to the style of Free Format entry.  The values are all within the
2000 range.  For example:

2001 - Open format area to store Text entries
2002 - Date format
etc

Example: If you are creating a Parameter that represents the start date of selected Job Orders
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then the full line could be:

Conditions: Job Date From;ORDERDATE>=:DATEFROM
Condition Index: 2002 (Date)

Note: If you only require a single Condition with Operator linked to the manual entry then you can
simply create a Parameter Line as follows

Conditions: Job Date;ORDERDATE>=:SCREENPARAM
Condition Index: 2002 (Date)

Condition 3 - Multiple Select Option

Ostendo contains many tables that are User maintained.  For example: Job Types, Item
Categories, etc.  This parameter format allows you to nominate one of these tables from which you
can make one or more selections from the drop-down list

The format of this type of parameter is DisplayName;Parameters linked to a Condition Index
where:

DisplayName is the text that you wish to appear on the parameter entry screen
Parameters has five elements

First Parameter: The output fields in the Master SQL should contain a field
whose content is user defined in a lookup Table.  (Example: Field JOBTYPE in
table JOBHEADER).  
Second Parameter: Refers to the Look-Up Table Name equating the field name
in the previous Table.  (Example: Table JOBTYPES equates to the field JOBTYPE
in Table JOBHEADER) 
Third Parameter: This refers to the field name in the Look-up table whose data
will form the drop-down list.  (Example” Field ORDERTYPE in Table JOBTYPES)
Fourth Parameter: The drop-down list will be sorted in the sequence defined by
this field.  Normally this will be the same as the Third Parameter but can be any
other field in the ‘Look-Up’ table

Condition Index For Look-Up related parameters this is always 3000

Example: If you are creating a Parameter in which you want to select (say) the Order Type from
the Job Type Table when selecting record from a Job Header then the full line could be:

Conditions: Job Type;JOBTYPE;JOBTYPES;ORDERTYPE;ORDERTYPE
Condition Index: 3000

Condition 4 - Pre-Defined Variables

Within Ostendo there are many pre-defined variables (such as Job Status) and are referred to as ‘
Domains’.  This parameter format allows you to point to the ‘Domain’ tables and select the specific
Table from which a selection or selections can be made.  Note: During Parameter entry all entries
in the nominated Domain Name Table are displayed in a drop-down list.  You have the option to
make one or more selections from that list

The format of this type of parameter is DisplayName;Condition linked to a Condition Index
where:

DisplayName is the text that you wish to appear on the parameter entry screen
Condition has two elements

Identifier: Enter a unique identifier that you are assigning to this parameter.  For
example: if the Domain is ‘Order_Status’ then this could be given an Identifier of ‘
OrderStatus’
Domain Name: The specific Domain Name.  There are around 150 Domain
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Names in Ostendo 
Condition Index For Domain related parameters this is always 4000

Example: If you are creating a Parameter in which you want to select (say) the Job Source
(Current options in the Domain ‘JOB_SOURCE’ are ‘Quote’, ‘Order’, ’Service’) then the full line
could be:

Conditions: Job Source;JSOURCE:JOB_SOURCE
Condition Index: 4000

Condition 5 – Defined Table Option

This Condition statement allows you to refer to any Table in Ostendo from which you can make a
selection from a list of displayed records from that Table.  This would commonly be used when
selecting from User-Defined Tables

The format of this type of parameter is 

DisplayName;ParamDef;TableName;Fields;Captions;ReturnedField;OrderBy where:

DisplayName is the text that you wish to appear on the parameter entry screen
ParamDef has three parts:

KeyField is the field name in the Query from which you making the comparison
Condition is the condition that you are applying to the parameter
TheStoredValue is a unique reference that you give this selected parameter

TableName is the name in the Table containing your selection
Fields are the Field Names from the selected Table that you wish to be displayed
Captions are the names that equate to the Fields and will be displayed in the extracted
column headings
ReturnedField is the field in the selected Table from which data will be returned and
populate the above ‘DisplayName’ Variable
OrderBy is the sort order by which the selected records will be displayed

Condition Index For this style of Parameter entry this is always 5000

Example: If you are creating a Parameter in which you want to select a Drawing Number from a list
of Drawings created in your own User-Defined Table then the full line would be:

Conditions:
Drawing_Number;DrawingNumber=:DrawingNumber;OSTDEF_DRAWINGREGISTER;Dr
awingNumber;Drawing;DrawingNumber;DrawingNumber
Condition Index: 5000

Condition 6 – User-Defined Selection Option

This Condition statement allows you to create user-defined values that will appear in a drop-down
list when run.  This is useful when used in conjunction with a User-Defined Table where the
variables are specified in the Edit View script.  It could also be used to restrict selections made
against base Ostendo Tables

The format of this type of parameter is DisplayName;Condition;Selections where:
DisplayName is the text that you wish to appear on the parameter entry screen
Condition has three elements

Field Name: The specific field within the Table identified within the Main Query
Operator: The specific Operator that you wish to apply to this parameter.  The
Available Operators are >, <, =, <>, >=, <=
Identifier: Enter a unique identifier that you are assigning to this parameter.
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Selections Each possible selection is entered separated by a comma.  Note: If the
selection contains a space in its identity (Example - In Progress) then it must be
surrounded by double quote ("In Progress")

Condition Index This is always 6000

Example: If you have a User-defined Edit View that contains the following options (Planned, In
Progress, Complete) against field Status then this condition would allow you to select the specific
Status for output.  Therefore the condition would be::

Conditions:Select Status:Status=:Status;Planned,"In Process",Complete
Condition Index: 6000

Condition 7 - User-Defined

User-Defined entries allow you to specify a Parameter and its format.  Upon entry of the parameter
it is stored in the 'Variables' of the Report and can be used to process activities within the report

The format of this type of parameter is DisplayName;{Format} linked to a Condition Index
where:

DisplayName is the text that you wish to appear on the parameter entry screen
{Format} This is the format of this entry {contained in ‘squiggly’ brackets}.  Data entry is
validated against this format although the value itself is stored as a String in the database. 
The validation options are:

· Boolean
· Integer
· String
· Date
· Time
· Double

Condition Index This is always 9000

Example: If you are creating a Parameter in which you provide the option to print the Run
Parameters then the full line could be:

Conditions: Exclude Parameters;{Boolean}
Condition Index: 9000

This is linked to an Exclude Parameters Variable in the Report Layout which you can then use this
to determine if the parameters are to be printed or not.

Section 4 - Detail Query Conditions

This uses the 'Conditions' panel in the Master Query Screen and its similar to the Master Query
Conditions except that you need to specify the Detail Data Query to which the Condition applies

This references the Detail Data Query Number along with the field within that query.  For example
if we wish to show a range of Job Orders held against a Range of Customers then the Master
Query would refer to the Customer data and Detail Data Query would refer to the linked Job
Orders.

To select the Range of Customers the following Conditions would apply.

 From Customer;CUSTOMER>=:CUSTFROM (Type) 1015 
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 To Customer;CUSTOMER<=:CUSTTO (Type) 1015 

To select the Range of Job Orders the following Conditions would apply.

 Job Order From;ORDERNUMBER>= :DDC_1_JOBFROM (Type) 1075
 Job Order To;ORDERNUMBER<= :DDC_1_JOBTO  (Type) 1075

Where DDC_1 represents the Detail Query Number to which the condition will apply

Additionally you may have additional Detail Queries that also link to the selected Job Order
Number.  For Example Job Order Lines (DD_2), Job Order Documents (DD_3), etc.  In this
instance you would simply extend the above condition to include the Detail Query Number -
separated by a #

 Job Order From;ORDERNUMBER>= :DDC_1#2#3_JOBFROM (Type) 1075
 Job Order To;ORDERNUMBER<= :DDC_1#2#3_JOBTO  (Type) 1075

Buttons

The following buttons are used to save the current Report, View, Chart, or Pivot in addition to
processing to the respective layouts

Close: This will close the Reports and Views Developer screen. 

Add: This will bring up a panel for defining the new Report, Analysis, Chart, or Pivot View.  You
can create a new report ‘from scratch’ or copy an existing format.  In either case it will create an
output who's ‘Level’ will be preset at ‘Company’.  On this panel the following fields are available.

Create from Scratch: Select this Radio Button if you are going to generate the Report,
Analysis, Chart, or Pivot View from scratch.  The following two fields will be presented
which must be completed

Type: Select the Radio Button that represents the type of view being created.  The
options are:

Report
Analysis
Chart
Pivot View

Name: Enter the Name of the view.  Duplicate Names are not allowed
Copy from Another: Select this Radio Button if you are going to generate the Report,
Analysis, Chart, or Pivot View by copying an existing view and using that as a start point. 
The following options are now presented

Output to be copied: From the drop-down list select the current Report, Analysis,
Chart, or Pivot View that will form the basis of the new report or view.  When
selecting this option you can define what will happen to the copied view as follows:
Copy to Company: Select this Radio Button to denote that the above  ‘Output to
be Copied’ document will replace and existing document of the same name in the
‘Company’ Reports folder
Add New to Company: Select this Radio Button to denote that the above ‘Output
to be Copied’ document will be used as the basis for creating a new report or view.
The name of the new should be entered into the next field
Name: Mandatory entry if the ‘Be an Additional’ Radio Button has been selected.
Duplicate Names are not allowed

Save: This will save the current data without exiting the screen
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Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.

Delete: Not applicable to this View

Edit: This will take you through the parameters currently held against this Report, View, Chart or
Pivot and then take you to the display for you to create and/or maintain the physical document. 
You should note the following:

Report: A blank report will be presented using the ‘Report’ or ‘Form’ Template selected in the
Main panel.  A simple Tutorial is available under Ostendo ‘Help’ that describes some of the
basic functions such as:

· Adding Data Fields
· Adding Text Fields
· Adding your Company Logo
· etc

View: A basic View will be presented using the definition entered into the Main panel.  A guide
to creating Views and formatting them to various output media is described in Ostendo ‘Help’. 
Any changes made by the user whilst in the view will be retained until the ‘Clear Selected Grid
Layout’ button is pressed on the Main panel - View option

Chart: The Chart will automatically show :
· The Main SQL ‘Select’ fields (non-numeric) across the top of the Chart 
· The Main SQL ‘Select’ Fields (Numeric) as the central display fields
· Note: The Last field across the top of the Chart is called the ‘Category’ and this is

lowest level that the Chart will display. 
A guide to creating Charts is given in Ostendo ‘Help’

Pivot: A base screen showing all the available fields will be presented.  You should position
them:

· Across the Horizontal Axis
· Across the Vertical Axis
· In the centre of the Pivot (Numeric fields only)
· Hide the field as not required in this view

The resultant Pivot View will automatically be saved.
A guide to creating and maintaining Pivot Views is given in Ostendo ‘Help’

Preview: This will take you through the parameters currently held against this Report or View and
then produce the output as if you were an end user. 

Export: If you click on this button then the current Report, View, Pivot, or Chart’s details will be
exported and generated as a .dat file.   You should note that, in the case of a Report, this does
NOT export the .fr3 file.  This must be copied separately if you are transferring the Report to
another Ostendo.

Import: If you click on this button then you will be asked to point to the .dat file generated using the
above ‘Export’ process.  Upon selecting the .dat file the Report, View, Pivot, or Chart’s details will
immediately be imported into the current (sign-on) Company.   You should note that, in the case of
a Report, you should also copy the specific .fr3 file into the ‘Company’ reports folder.
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2.3 Condition Indexes

Condition Indexes are used in:

· Ostendo’s Pre-defined Functions ( AskMandatoryQuestionWithLookup and
AskQuestionWithLookup) to define the Table being referenced and use the ‘Lookup’ or ‘
Variable’ Type parameters only

· Report and View Developer in the run Parameter Section to define the type of parameter being
entered

Each parameter contains three fields

Ref#:  This is the reference Number used in the Function or Parameter to define what is being
addressed.

Description:  This is the Table Name, or entry Type of the Parameter.

Type:  This is the Type of Parameter.  The options are:

Lookup - Refers to the Ostendo Table outlined in ‘Description’.  When this is used then
Ostendo will show a ‘drop-down’ list of records from the referenced Table for selection
from that table.
Editor - Refers to a field that (optionally) requires an entry which, when entered, is
validated against the format defined in the Description field
Editor(Checklist - Table) - When used this allows you to reference an Ostendo Table.
When used as a parameter all the records in the table are shown in a drop-down list from
which you can select one or more lines by ‘checking’ a checkbox against the required
line(s)
Editor(Checklist - Domain) - When used this allows you to reference a ‘Domain’ table in
Ostendo.  A ‘Domain’ is a pre-defined list of ‘fixed’ values such as Order Status (Planned,
Open, etc).  When used as a parameter all the values in the Domain are shown in a
drop-down list from which you can select one or more values by ‘checking’ a checkbox
against the required value(s)
Variable - This allows you to enter a variable value that can be passed to the Report and
used within the Report’s ‘Code’ section.  The variable format options are Boolean, Integer,
String, Date, Time, Double.

Current Parameter Types:

Ref#    Description Type
1000 PriceLevel Lookup
1001 Supplier Lookup
1002 Standard Units Lookup
1003 Locations Lookup
1004 Items Lookup
1005 Adjustment Types Lookup
1006 Credit Terms Lookup
1007 Categories Lookup
1008 Inventory Templates Lookup
1009 Price Group Lookup
1010 Descriptors Lookup
1011 Item Batch Lookup
1012 Item Color Lookup
1013 Item Grade Lookup
1014 Item Size Lookup
1015 Customers Lookup
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1016 Employee Buyer Lookup
1017 Tax Groups Lookup
1018 Company Address Lookup
1019 Purchase Types Lookup
1020 Shipping Method Lookup
1021 Workflow Status Lookup
1022 Tax Codes Lookup
1023 Location Groups Lookup
1025 Pricing Groups Lookup
1027 Analysis Groups Lookup
1028 Customer Types Lookup
1029 Customer Regions Lookup
1030 Customer Codes Lookup
1031 Customer Lead Sources Lookup
1032 Warranty Codes Lookup
1033 Article Types Lookup
1034 Article Categories Lookup
1035 Supplier Types Lookup
1036 Supplier Regions Lookup
1037 Supplier Codes Lookup
1038 Resources Lookup
1039 Departments Lookup
1040 Employees Lookup
1041 Asset Types Lookup
1042 Kitsets Lookup
1043 Sales Types Lookup
1044 Employee Sales Person Lookup
1045 Customer Shipping Method Lookup
1046 Sales Order Delivery Lookup
1047 Descriptors (General Purpose) Lookup
1048 Deliveries Ready To Invoice Lookup
1049 Job Type Lookup
1052 Resources (Assets) Lookup
1053 Company (Assets) Lookup
1054 Projects Lookup
1055 Equipment-Customer Asset Lookup
1056 Job Tasks Lookup
1057 Task Bills Lookup
1058 Job Templates Lookup
1059 Warehouse Lookup
1061 Job Category Lookup
1062 Descriptor (TaskBill) Lookup
1063 Labour Codes Lookup
1064 Item Properties Lookup
1065 Descriptor Properties Lookup
1066 Labour Properties Lookup
1067 Contract Lookup
1069 Rate Level Lookup
1070 Warranty List Lookup
1071 List Master Lookup
1072 Articles Lookup
1073 Template Tasks Lookup
1074 Notes Categories Lookup
1075 Job Orders Lookup
1076 Contract Number Lookup
1077 Cost Centre (Excl Map Restricted) Lookup
1078 Rate Scales Lookup
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1079 Project Types Lookup
1080 Service Plan Code Lookup
1081 Assembly Tracking Code Lookup
1082 Assembly Orders Lookup
1083 Routing Template Lookup
1084 Job Categories Lookup
1085 Purchase Orders Lookup
1086 Cost Centre (All) Lookup
1087 Std Properties Lookup
1088 Payment Method Lookup
1089 Payment Account Lookup
1090 Customer Deposits Lookup
1091 Credits Lookup
1092 Sales Orders Lookup
1093 Sales Orders - Counter Lookup
1094 Invoice Group Lookup
1095 Invoices Lookup
1096 Invoices- All Lookup
1097 Statement Cycles Lookup
1098 Call Classifications Lookup
1099 Call Sub Classifications Lookup
1100 Sales Orders - Deliverys Lookup
1101 Locations ReturnSysId Lookup
1103 Standard Units - Time Unit Lookup
1104 Call Resolution Codes Lookup
1105 Items - Custom Lookup
1106 Customer Asset Type Lookup
1107 Cost Groups Lookup
1108 Sales Workflow Status Lookup
1109 Invoices-excl credits and planned status Lookup
1110 Items - Non Custom Lookup
1111 Items - Assembly Lookup
1112 Item Revision Lookup
1113 Quote Lost Reasons Lookup
1114 Job Orders - open and in progress Lookup
1115 Assembly Orders - open and in progress Lookup
1117 Job Orders - Quotes Lookup
1118 Tasks Lookup
1119 Steps Lookup
1120 Kitsets From Kitset Master Lookup
1121 Service Confirm Lookup
1122 Invoices - Printed Lookup
1123 Users Lookup
1124 Manufacturers Lookup
1125 Financial batches Lookup
1127 Items- from BOMMaster - Assembly Order Lookup
1128 Purchase Orders - not closed Lookup
1129 Cost Center - Job no debtor Lookup
1130 Call Centre Ticket ID Lookup
1131 Catalogue Lookup
1132 Scrap Codes Lookup
1133 Common text Lookup
1135 PO Shipments Workflow Status Lookup
1136 Supplier Shipping Type Lookup
1137 Currency Codes Lookup
1138 Purchase Shipments - not closed Lookup
1139 POS Station ID Lookup
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1140 Payment Method - POS Lookup
2001 Text Editor
2002 Date Editor
2003 CheckBox Editor
2004 Decimal Editor
2005 Currency Editor
2006 Integer Editor
2007 Time Editor
3000 CheckList (From Table) Editor
4000 CheckList (From Domain) Editor
5000 Select from defined Table Editor
9000     Variable Editor
      Available Index 9000 formats are:

· Boolean
· Integer
· String
· Date
· Time
· Double

  

2.4 Detail Query Screen

This screen allows you to create:
· 20 additional sub queries for reports
· 1 additional sub query for Analysis Views
· 1 additional sub query for Edit Views
· 12 additional sub queries for Inquiries

For instructions on SQL refer to the SQL Section in this Help Guide.  Each Sub Query contains the
following fields

Query #: This allows you to define a sub-query linked to the Main, or a higher level, SQL (see the
next field).  

Link to Query #:  This enables you to define the ‘Level’ that the Query occupies and therefore to
which parent Query it is joined. For example:

Any Query at Level 0 will be Left Joined to the Master SQL
Any Query with Level 1 will be Left Joined to the immediate previous Level 0
Any Query with Level 2 will be Left Joined to the immediate previous Level 1
Etc…

SQL Builder: Supporting screen to help you design your query.  On the displayed screen there are
three panels

Tables - The names of all the Tables (database files) that are used by Ostendo
Fields - Having selected a specific Table this will show each field in that Table
Query - This is where you create and maintain the query as described below

You can enter a query in one of two ways
§ Type in directly
§ Create using ‘prompts’

To create using ‘prompts’ you can copy:-
§ Tables to the Query by selecting the table and either double clicking the left mouse
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or clicking on the ‘Add Table to Query’ button
§ Fields to the Query by first selecting the correct Table then the field and either

double clicking the left mouse or clicking on the ‘Add Field to Query’ button
§ Keywords to the Query by clicking the ‘Options’ button and selecting ‘Add Keyword’

and then selecting the appropriate keyword.    Available Keywords are Select, *,
Sum, Count, From, Where

§ Operators to the Query by clicking the ‘Options’ button and selecting ‘Add Operator’
and then selecting the appropriate Operator.   Available Operators are >, <, =. <>,
+, -, /

You should note that for Inquiries the query must contain a SysUniqueID.  See the previous
section (Master Settings Screen) for more information.

The following buttons are used ito save the current Report, View, Chart, or Pivot in addition to
processing to the respective layouts

Buttons

The following buttons are used to save the current Report, View, Chart, or Pivot in addition to
processing to the respective layouts

Close: This will close the Reports and Views Developer screen. 

Add: This will bring up a panel for defining the new Report, Analysis, Chart, or Pivot View.  You
can create a new report ‘from scratch’ or copy an existing format.  In either case it will create an
output who's ‘Level’ will be preset at ‘Company’.  On this panel the following fields are available.

Create from Scratch: Select this Radio Button if you are going to generate the Report,
Analysis, Chart, or Pivot View from scratch.  The following two fields will be presented
which must be completed

Type: Select the Radio Button that represents the type of view being created.  The
options are:

Report
Analysis
Chart
Pivot View
Inquiry
Edit View

Name: Enter the Name of the view.  Duplicate Names are not allowed
Copy from Another: Select this Radio Button if you are going to generate the Report,
Analysis, Chart, or Pivot View by copying an existing view and using that as a start point. 
The following options are now presented

Output to be copied: From the drop-down list select the current Report, Analysis,
Chart, or Pivot View that will form the basis of the new report or view.  When
selecting this option you can define what will happen to the copied view as follows:
Copy to Company: Select this Radio Button to denote that the above  ‘Output to
be Copied’ document will replace and existing document of the same name in the
‘Company’ Reports folder
Add New to Company: Select this Radio Button to denote that the above ‘Output
to be Copied’ document will be used as the basis for creating a new report or view.
The name of the new should be entered into the next field
Name: Mandatory entry if the ‘Be an Additional’ Radio Button has been selected.
Duplicate Names are not allowed

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.
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Delete: Not applicable to this View

Edit: This will take you through the parameters currently held against this Report, View, Chart or
Pivot and then take you to the display for you to create and/or maintain the physical document. 
You should note the following:

Report: A blank report will be presented using the ‘Report’ or ‘Form’ Template selected in the
Main panel.  A simple Tutorial is available in this ‘Help’ that describes some of the basic
functions such as:

· Adding Data Fields
· Adding Text Fields
· Adding your Company Logo
· etc

View: A basic View will be presented using the definition entered into the Main panel.  A guide
to creating Views and formatting them to various output media is described in this ‘Help’.   Any
changes made by the user whilst in the view will be retained until the ‘Clear Selected Grid
Layout’ button is pressed on the Main panel - View option

Chart: The Chart will automatically show :
· The Main SQL ‘Select’ fields (non-numeric) across the top of the Chart 
· The Main SQL ‘Select’ Fields (Numeric) as the central display fields
· Note: The Last field across the top of the Chart is called the ‘Category’ and this is

lowest level that the Chart will display. 
A guide to creating Charts is given in this ‘Help’

Pivot: A base screen showing all the available fields will be presented.  You should position
them:

· Across the Horizontal Axis
· Across the Vertical Axis
· In the centre of the Pivot (Numeric fields only)
· Hide the field as not required in this view

The resultant Pivot View will automatically be saved.
A guide to creating and maintaining Pivot Views is given in this ‘Help’

Preview: This will take you through the parameters currently held against this Report or View and
then produce the output as if you were an end user.
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3 Introduction to SQL

Ostendo uses SQL (Structured Query Language) to enable you to view information in your
database.  This document explains how SQL extracts that data in addition to demonstrating some
of the more common SQL commands used to display data from your Ostendo Database.   

3.1 Simple Data Enquiry

Let us commence with making an enquiry into the Customer Master file.  You should begin by
opening up the Spreadsheet (General>Data Spreadsheet).  Click on ‘Data’ on the top toolbar and
select ‘Query Builder.  A screen will appear with four panels.

Tables: The Table names currently in Ostendo
Fields: The available fields within the selected Table
Query: The current Query
Selection Criteria: Parameter selection criteria

Scroll down in the ‘Table’ panel and find CUSTOMERMASTER.  If you select this then the fields in
that Table will appear in the ‘Fields’ panel

For the purpose of demonstrating how Ostendo’s SQL Builder works let us assume that the
CustomerMaster contains the following information 

Customer CustomerType DiscountPercent PrimaryContact PriceLevel

Best Customer Local 10.0 Fred Flint Trade

Green Fingers National 5.0 Rose Bloom Trade

Jim Beam Local 10.0 John Walker Retail

Lazy Bones International 0.0 Overseas

Equity Inc International 0.0 Brian Cash Overseas

Farm Fodder National 5.0 John Bull Trade

The most common command line used is

SELECT * from CUSTOMERMASTER

This instruction tells the program to select * (I.e. * = All fields) from File ‘CUSTOMERMASTER’
and output all data held against every Customer in your database.  
Click on the ‘Run’ Button to run the Query.  You will be asked if you want to ‘Save’ it first.  It is
suggested that you do this because you can recall this Query and amend it later.

Obviously there are two additional options you may wish to apply to this statement
· Only display selected fields
· Only display selected records

3.2 Display selected Fields

To display selected fields replace the * with the field names – each separated with a comma.    For
example, if we only select the following fields:-

SELECT Customer, CustomerType, DiscountPercent from CustomerMaster
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The output will now look like this

Customer CustomerType DiscountPercent

Best Customer Local 10.0

Green Fingers National 5.0

Jim Beam Local 10.0

Lazy Bones International 0.0

Equity Inc International 0.0

Farm Fodder National 5.0

3.3 Display selected Records

To display selected records you may extend the statement to read (say)

SELECT Customer, CustomerType, DiscountPercent from CustomerMaster where PriceLevel = ‘
Trade’

The output will look like this

Customer CustomerType DiscountPercent

Best Customer Local 10.0

Green Fingers National 5.0

Farm Fodder National 5.0

Two points to note here:
· The conditional ‘PriceLevel’ field is in single ‘quotation’ marks.  (This applies to all

non-numeric fields)
· The conditional ‘PriceLevel’ field does not have to be included in the display

The following example shows a conditional statement where the selection criteria is against a
numeric field.

SELECT Customer, CustomerType, DiscountPercent from CustomerMaster where
DiscountPercent > 6

The output will look like this

Customer CustomerType DiscountPercent

Best Customer Local 10.0

Jim Beam Local 10.0
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3.4 Data extraction from two Tables

Let’s look at the situation where Customer information is held against the CUSTOMERMASTER
table and Sales Orders are held in a SALESHEADER Table and we would like to combine data
from both tables for output to the Spreadsheet.

Table CUSTOMERMASTER

Customer CustomerType DiscountPercent PrimaryContact PriceLevel

Best Customer Local 10.0 Fred Flint Trade

Green Fingers National 5.0 Rose Bloom Trade

Jim Beam Local 10.0 John Walker Retail

Lazy Bones International 0.0 Overseas

Equity Inc International 0.0 Brian Cash Overseas

Farm Fodder National 5.0 John Bull Trade

Table SALESHEADER

Customer OrderNumber OrderStatus OriginalOrderAmount

Best Customer SO10024 Open 1200.00

Best Customer SO10056 On Hold 365.55

Jim Beam SO10123 Open 1526.50

Farm Fodder SO10010 Closed 1200.00

Best Customer SO10205 Quote 365.55

Jim Beam SO10128 Open 1000.50

Jim Beam SO10143 Open 856.50

The field Customer in the CustomerMaster table contains compatible information to Customer in
the SalesHeader Table therefore we need to tell SQL to match these up.   Therefore create the
following SQL:-

SELECT * from CustomerMaster, SalesHeader
where CustomerMaster.Customer = SalesHeader.Customer

· The main points to note here are that:-
o Both tables are specified and separated by a comma
o The Where statement shows a specific Table and Field Name (with a ‘period’

separating them) in the primary table matching it to its equivalent Table and Field
Name in the other table

This would produce the following display

Customer Customer
Type

Discount
Percent

Primary
Contact

Price
Level

Order
Number

Order
Status

Order Amt
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Best Customer Local 10.0 Fred Flint Trade SO10024 Open 1200.00

Best Customer Local 10.0 Fred Flint Trade SO10056 On Hold 365.55

Best Customer Local 10.0 Fred Flint Trade SO10205 Quote 365.55

Green Fingers National 5.0 Rose Bloom Trade

Jim Beam Local 10.0 John Walker Retail SO10123 Open 1526.50

Jim Beam Local 10.0 John Walker Retail SO10128 Open 1000.50

Jim Beam Local 10.0 John Walker Retail SO10143 Open 856.50

Lazy Bones International 0.0 Overseas

Equity Inc International 0.0 Brian Cash Overseas

Farm Fodder National 5.0 John Bull Trade SO10010 Closed 1200.00

· For every occurrence of a Sales Order record a combined Customer / Sales Order record
is displayed

· Where a Customer record does not have an equivalent Sales Order record then it is
moved to the display with blanks in the Sales Order field area

You will note, therefore, that Customer ‘Best Customer’ has three display records – one for each
Sales Order record.

3.5 ‘And’ or ‘Or’ selections

You can use the operands ‘And’ and ‘Or’ in your select statement

Select * from CustomerMaster where (CustomerType = ‘Local’ or CustomerType = ‘National’) and
PriceLevel = 'Trade'

Like all Boolean equations the Select routine will address the conditions within the brackets before
applying the remainder of the statement.  The output will now look like this.

Customer CustomerType DiscountPercent PrimaryContact PriceLevel

Best Customer Local 10.0 Fred Flint Trade

Green Fingers National 5.0 Rose Bloom Trade

Farm Fodder National 5.0 John Bull Trade

3.6 Order By

The ‘Order By’ command simply sorts the records in the sequence that you require. For example
the Query

SELECT * from CustomerMaster, SalesHeader
where CustomerMaster.Customer = SalesHeader.Customer and CustomerMaster.CustomerType
= ‘Local’
Order By OriginalOrderAmount

Will extract all Customer / Sales Order records and sort them into ascending Order Value
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Customer Customer
Type

Discount
Percent

Primary
Contact

Price
Level

Order
Number

Order
Status

Order Amt

Best Customer Local 10.0 Fred Flint Trade SO10056 On Hold 365.55

Best Customer Local 10.0 Fred Flint Trade SO10205 Quote 365.55

Jim Beam Local 10.0 John Walker Retail SO10143 Open 856.50

Jim Beam Local 10.0 John Walker Retail SO10128 Open 1000.50

Best Customer Local 10.0 Fred Flint Trade SO10024 Open 1200.00

Jim Beam Local 10.0 John Walker Retail SO10123 Open 1526.50

You should note that the ‘Order By’ field need not be one of the displayed fields.   You should also
note that if the sort were required in Descending Order then the above statement would have the
word ‘Desc’ added to the sorted field to give

SELECT * from CustomerMaster, SalesHeader
where CustomerMaster.Customer = SalesHeader.Customer and CustomerMaster.CustomerType
= ‘Local’
Order By OriginalOrderAmount Desc

3.7 Summaries

You can use Select statements to summarise or sort the extracted records as follows.

Distinct

The ‘Distinct’ command simply creates one output record for each unique occurrence within a field.
 For example the Query

Select Distinct CustomerType from CustomerMaster

Will return an Analysis form showing only column ‘Gender’ and each unique occurrence within that
column will be printed once.

CustomerType

Local

National

International

Count

The ‘Count’ command simply adds up the number of records that satisfy the Selection and return a
number. 

For example the Query

SELECT Count(*) from CustomerMaster

Will return a count of all the records in the Customer Master file
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Count

6

If you had this Query

SELECT Count(PrimaryContact) from CustomerMaster

Then the count will be different because the ‘Count’ statement only counts the number of records
that has a value in the ‘PrimaryContact’ field.    In the above example Customer  ‘Lazy Bones’ did
not have a Primary Contact therefore that record will not be included in the count.

Count

5

Average, Min, Max, Sum

For these examples we will use the DiscountPercent field against the CustomerMaster Record.    

1. The following query will return the Average Pay Per Hour.

SELECT AVG(DiscountPercent) from CustomerMaster

Would return 1 value corresponding to the average value of Discount Percent that exist in the
Customer Master table.

Average

5.00

2.   Similarly the following summary values can be extracted

SELECT Max(DiscountPercent) from CustomerMaster

Returns the maximum Discount Percentage among all records in the Customer Master table.

SELECT Min(DiscountPercent) from CustomerMaster

Returns the minimum Discount Percentage among all records in the Customer Master table.

SELECT Sum(DiscountPercent) from CustomerMaster

Returns the sum of all the Discount Percentages found in the Customer Master table.

3.8 Group By

The GROUP BY function is used in conjunction with the aggregate statements like SUM, AVG ,
etc.  This allows the aggregate statements to be calculated upon change of ‘Group’.  For example
the statement :

SELECT Customer, SUM(OriginalOrderAmount) FROM SalesHeader GROUP BY Customer
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Will produce a result where the ‘Sum’ is shown for each ‘Group’ output

3.9 Having

The HAVING keyword is used when the WHERE keyword cannot be used against aggregate
functions (like SUM). Without the HAVING keyword it would not be possible to test for function
result conditions. For example

SELECT Customer, SUM(OriginalOrderAmount) FROM SalesHeader GROUP BY Customer
having Sum(OriginalOrderAmount)>1000

Returns only those summary records where the sum of the field OriginalOrderAmount  is greater
than 1000

3.10 Alias

The ‘Alias’ command allows you to output the column headings in more meaningful English than
the Database Name. For example, using the following Query we will change the column heading 
‘AdjustmentDate’ to read ‘Transaction Date’

Select ADJUSTMENTDATE as "Transaction Date", ADJUSTSOURCE as "Trans Source",
ADJUSTTYPE as "Trans Type", ITEMCODE as "Item Code"
from INVENTORYTRANSACTIONS

When carrying out an Alias you should note that :
· The Alias cannot contain spaces. You can use an underscore between words
· There is no comma between the database field and its Alias name

3.11 Joins

In 'Data Extraction from two Tables'  you looked briefly at connecting two tables CustomerMaster
and SalesHeader.

To recap that example we are ‘joining’ the tables such that all Sales Orders information for a
Customer is directly linked to the Customer record using the query

SELECT * from CustomerMaster, SalesHeader
where CustomerMaster.Customer = SalesHeader.Customer

Let’s have a look at what this is saying

§ From CustomerMaster, SalesHeader defines from which tables to extract the data

§ Where CustomerMaster.Customer = SalesHeader.Customer tells the program to only extract
the records where the field Customer in the CustomerMaster table matches the Customer in the
SalesHeader table.

Note : Although the specific field name is preceded with the table name in the above example it is
not necessary if the field name is unique. However it is good practice to include the table name.

1. Inner Joins

First, what are Inner Joins? These are the most commonly used type of Joins and are almost the
same as what was carried out above. Check the following query
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SELECT * FROM (CustomerMaster INNER JOIN SalesHeader ON CustomerMaster.Customer =
SalesHeader.Customer)

This gives exactly the same result as the following query

SELECT * from CustomerMaster, SalesHeader
where CustomerMaster.Customer = SalesHeader.Customer

Why the difference?  Basically Inner Joins combines all the records in the first table
(CustomerMaster) with all the records in the second table (SalesHeader) and then selects those
rows depending on the criteria present after the ON keyword in the query.
The most important thing to remember with Inner Joins is that only records from both the tables
are combined where there is a corresponding value in both the tables. This means that if the
CustomerMaster does not have any SalesHeader records then the CustomerMaster record will
NOT be extracted

2. Outer Joins

What are Outer Joins? These are similar to Inner Joins, but in Outer Joins all the records in one
table are combined with records in the other table even if there is no corresponding common
value.  Therefore if the CustomerMaster does not have any SalesHeader records then the
CustomerMaster record will be output.

There are 2 types of Outer Joins - Left Join and Right Join. 

2.1.   Consider an example of Left Join

SELECT * FROM (CustomerMaster LEFT JOIN SalesHeader ON CustomerMaster.Customer =
SalesHeader.Customer)

This query would match all Customer Master records with Sales Order Headers and output a
record where there is a match. In addition, where a Customer does not have a matching Sales
Header record, then a query extract record is still output but the Sales Header content is blank

2.2.   Consider an example of Right Join

SELECT * FROM (CustomerMaster RIGHT JOIN SalesHeader ON CustomerMaster.Customer =
SalesHeader.Customer)

This query would match all Customer Master records with Sales Order Headers and output a
record where there is a match.  In addition, where a Sales Header record does not have a
matching Customer Master record, then a query extract record is still output but the Customer
content is blank
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4 Creating and Maintaining Reports

Ostendo’s Report Writer has been developed to make the maintenance of reports as simple and
as user-friendly as possible.  This document outlines the available steps that allow you to amend
any of the current Reports in Ostendo.    

A Report is built around two basic elements

Bands tell the program when to print its contents
Fields tell the program where to print the information within the band  

This section describes

· Report Styles
· Bands and where they are used
· Fields and field types that can be entered into the above bands.
· Expressions generation to facilitate totalling, etc
· Conditional printing options with pre-defined example

4.1 Report Creation Wizard

Whenever a Report is being created and the ‘Edit’ button is pressed in the Master Settings screen
a panel is presented to help you define a starting point for the new Report.  Three options are
available:

Option 1.  You can use an existing Report’s Format as the basis for the new Report by clicking on
the ‘Templates’ tab and selecting the specific Report. 

Option 2. You can construct a Report ‘from scratch’ by using a ‘Wizard’.  This contains the
following steps

Step 1 - Data: This panel allows you to identify the dataset(s) from which the fields will be
extracted.  The basic datasets shown are:

SYS_   This contains all the fields relating to your Company
SC_  This shows the parameters that have been identified against this Report
MD_  This shows the fields extracted via your Master Query (above)
DD_#  This shows the Detail-queries that were created against the Report.  The #
after the DD_ identifies the Detail-query number in the Detail Query List

Select the dataset then click on the ‘Next’ button

Step 2 - Fields: This panel shows the available fields within the dataset selected above.
Select the field(s) that you want to appear on the Report and move them to the right side
of the screen.   Click on the ‘Next’ Button when done.

Step 3 - Groups: This is an optional step that allows you to Group the extracted records.
You should note that the Query used to extract this data should also include an ‘ORDER
BY’ statement to reflect the grouping being defined here.  The left side of the screen
shows the extracted fields defined in step 2.  Select the ‘Group By’ field(s) and move to the
right-hand area.  Click on the ‘Next’ Button when done.

Step 4 - Layout: Select the following:
Orientation:- Landscape or Portrait
Layout:- Tabular or Columnar (The display to the right of the panel will reflect the
selection)
Fields Fit to Width:- If ‘checked’ then the selected fields will be restricted to the
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width of the page and field concatenation could occur.  If not ‘checked’ then the
field will continue into a second (and third line) if necessary to show all the data.

Click on the ‘Next’ Button when done.

Step 5 - Style: Select the Report Style that you wish to use.  The options are Bold,
Standard, Soft Gray, or Corporate.  The picture to the right of the panel shows an example
of the report style. Click on the ‘Finish’ Button when done.

Option 3. You can construct a Report ‘from scratch’ by starting with a blank ‘palette’ by selecting
on the ‘Standard Report’ icon and clicking on the ‘OK’ button.  A blank report will be presented.
You now need to make the Datasets and their available for inclusion in the report.  To do this you
should select Reports on the top toolbar and choose ‘Data’ from the dropdown list.  ‘Check’ those
datasets from which you wish to select fields and click the ‘OK’ button.

4.2 Report Styles

The most common report formats used in Ostendo are:-

Straight ‘List’ Report - Example: List of Inventory Items
Grouped List Report - Example: List of Sales Orders and their Lines
Full Page Report - Example: Job Sheet, Purchase Order

Other available formats are:-

Multi-Column Report - Example: Labels, etc
Cross Tab Report - Example: Value analysis of related fields

4.3 Report Bands

A Band is an area within a Report that tells the program when to print the information contained
within it.  For example a Report Title Band will, as you would expect, print the content of the Band
once at the beginning of the Report.

For your information Bands are created as follows:-

On the left of the blank report you will see a Toolbar.      

   Click on the ‘Insert Band’ Icon and select the Band from the drop-down list.   

The displayed Band has two portions.  The upper (Blue) portion tells you what type of Band it is
and the lower portion is where you place the fields to be printed.  If you click on the Band then
eight ‘Handles’ will appear.  You can drag and drop these handles to increase or decrease the
space occupied by the band in the finished report.

3.1. Types of Bands

These are the more common bands used in Ostendo reports

3.1.1.   Report Title Band
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A Title Band appears once at the beginning of a Report and is used to identify the name of the
Report but you can also add Date and Time when the report was run.       

3.1.2.   Report Summary Band

A Report Summary Band appears once at the end of a Report and is used to include summary
information such as Report totals, record counts, etc

3.1.3.   Page Header Band

A ‘Page Header Band’ always appears at the top of each generated Page in the Report.  You can
use this Band to enter information such as a Page title, current Date and Time, or Page Number.

3.1.4.   Page Footer Band

A ‘Page Footer Band’ always appears at the bottom of each generated Page in the Report. You
can use this Band to enter information such as your company contact details, current Date and
Time, Page Number, etc

3.1.5.   Master Data Band

A ‘Master Data Band’ is the main Band when producing Reports. Database fields entered into this
Band will print once for each record being read.  Additionally, any Text, Lines, Rectangles, etc
entered into this Band will also print along with each record extracted.  In a ‘Straight List’ or ‘Full
Page’ report this is the only band that is used

3.1.6.   Detail Data Band

A ‘Detail Data Band’ is similar in function to the ‘Master Data’ Band.  This band is used to print
sub-level data relative to the Master Band.  An example of this is where the Master Data Band
prints Sales Order Header Information and the Detail Data Band prints the Sales Order Line
information.     

3.1.7.   Header Band

A ‘Header Band’ can be placed above the ‘Master Data’ and ‘Detail Data’ Bands and enables you
to add Text, etc to denote what the Data fields represent.  For example: Customer, Customer
Address, etc

3.1.8.   Footer Band

A ‘Footer Band’ can be placed immediately after the ‘Master Data’ and ‘Detail Data’ Bands and
enables you to not only add Text, but also carry out summary information such as totals, record
counts, etc for the included Master/Detail Bands

3.1.9.   Group Header Band

A ‘Group Header Band’ enables you to group together ‘like’ records and print out the ‘Grouping’
once only at the beginning of the Group.   For example; when printing all Sales Orders for a
specific Customer you would require the Customer Information to be printed once, immediately
followed by details of the Sales Orders for that Customer

3.1.10.   Group Footer Band

A ‘Group Footer Band’ is placed at the end of the included Master Data and Detail Data records
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and enables you to carry out summary information such as totals, record counts, etc for the Group.

3.1.11.   Child Band

A ‘Child Band’ provides facility to optionally print information when linked to a Master Data or Detail
Data record.  This can be used, for example, when ‘Extended Notes’ may - or may not - exist in a
record.  Where it does not exist then you can instruct the Report not to print the Child Band thus
avoiding a blank area in the report.  

4.4 Fields and Field Types

Fields are items of information that placed within a Band. This can be simple Text, Database Data,
Calculated fields, etc.  The method by which the field is defined is the same.   However, additional
tools are available to assist in identifying database fields, defining Calculations, etc and these are
described in detail in the ‘How Do I” section..

4.1   Creating a Field

  On the Toolbar click on the ‘Text Object’ Icon then move the cursor to the report and place
the displayed rectangle into the lower part of the Band as shown below

The following panel will appear

                        
Information can be keyed directly into this screen that informs the Print program what to print.   
Here are a few simple examples.  

Creating simple Text (for use in column Headings, Field descriptions, etc

 

This references a database field and comprises of
   - Surrounded by a ‘Square’ bracket
   - Table Name (In this example ‘Customer)
   - Field in the Table (Example “Company”)

This shows a calculated field that multiplies Unit Order quantity by List Price and comprises
   - Surrounded by a ‘Square’ bracket
   - Table/Field Name enclosed in <>
   - Multiplication sign between the two fields
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This is the previous extended price field that has been summated for display in a Footer Band and
comprises

   - The previous statement plus
   - SUM around the fields to be summated

This shows how you can combine both Text and Data fields in the same print field and comprises
   - Text in free format
   - Data in Square Brackets 

4.5 Creating a Data Field

   On the Toolbar click on the ‘Text Object’ Icon then move the cursor to the report and place
the displayed rectangle into the lower part of the Band as shown below

The following panel will appear

Click on the fx icon to display the list of fields

‘Double Click’ on the required field and you will see it displayed in the bottom panel

Click the ‘OK’ button to return to the ‘Memo’ screen  which will look like this

Click the green ‘tick’ to return to the main report, which will show the field in the report.   For
example:-

  If you now click on the ‘Preview’ Icon you can see the finished listing.  For example:
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4.6 Changing a Data Field

Click on the field and then on the down arrow to the right of the field to display the available fields

Select the required field.

4.7 Creating a Text Field

  On the Toolbar click on the ‘Text Object’ Icon then move the cursor to the report and place
the displayed rectangle into the lower part of the Band as shown below

The following panel will appear

Simply Key in the column title and then click the green ‘tick’.

Run the report in ‘Preview’ mode.  

You can use other tools to enhance the result such as
· Increasing the Font size
· Printing in ‘Bold’
· Changing the Colour
· Adding a separator line (using the ‘Line Object’ in the left toolbar)
· Increasing the depth of the Page Header Band
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4.8 Adding a Date to the Report

A date can be added to print out:-
· Once on a Report at the beginning of the report
· On each page in the Page Header and/or Page Footer

  

On the Toolbar click on the ‘Text Object’ Icon then move the cursor to the report and place the
displayed rectangle into the lower part of the Band as shown below

The following panel will appear

On the displayed ‘Memo’ panel click on the fx icon to display the Expression Editor

Select the ‘Variables’ Tab and double click the mouse on ‘Date’ within that display.  Click the ‘OK’
button to return to the ‘Memo’ panel

The ‘Memo’ screen will be filled with [DATE].  Click the green ‘tick’ to confirm the entry and return
to the Report.

Run the report in ‘Preview’ mode.  

Of course you would also need to indicate that this is a date so return to the Memo panel and type
in the required Text
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Again, run the report in ‘Preview’ mode.  

4.9 Adding Page Numbers to a Report

A Page Number can be added to print out:-
· On each page in the Page Header 
· On each page in the Page Footer

 
On the Toolbar click on the ‘Text Object’ Icon then move the cursor to the report and place the
displayed rectangle into the lower part of the Band as shown below

The following panel will appear

On the displayed ‘Memo’ panel click on the fx icon to display the Expression Editor.

Select the ‘Variables’ Tab and double click the mouse on ‘Page’ within that display.  Click the ‘OK’
button to return to the ‘Memo’ panel

The ‘Memo’ screen will be filled with [Page]. Click the green ‘tick’ to confirm the entry and return to
the Report.

Run the report in ‘Preview’ mode.  

Of course you would also need to indicate that this is a Page Number.  Therefore you can type in
the description of the number
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Again, run the report in ‘Preview’ mode.  

4.10 Adding a Report Title

A Report Title appears once at the beginning of a Report.   This can be:-
· On its own page or
· On the first page prior to the data being printed

Report Title on its own page      

If you wish to place the Title on its own page at the beginning of the report then carry out the
following

On the outside of the current Report Page you will see a ‘Tab’ with the title of the current page. 
Click Right Mouse on this and select ‘Add Page’ to create a new page.  

You now need to move the data from Page 1 to the new Page 2. therefore:- 
    - Go back to Page 1 and select Edit>Select All

- Select Edit>Cut then got to Page 2
- Select Edit>Paste 

   - Drag and drop the copied information.

Return to Page 1 and carry out the following

 

Click on the ‘Insert Band’ Icon and select the Report Title Band from the drop-down list.   

The displayed Band has two portions.  The upper portion tells you that it is a Report Title Band and
the lower portion is where you place the Title.  If you click on the Band then eight ‘Handles’ will
appear.   You can drag and drop these handles to increase or decrease the space occupied by the
band in the finished report.

Insert a Text Object into this Band and create the Title  

Report Title on the first page  
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Click on the ‘Insert Band’ Icon and select the Report Title Band from the drop-down list.  

 

The displayed Band has two portions.  The upper portion tells you that it is a Report Title Band and
the lower portion is where you place the Title.     If you click on the Band then eight ‘Handles’ will
appear.   You can drag and drop these handles to increase or decrease the space occupied by the
band in the finished report.

Insert a Text Object into this Band and format the Text 

4.11 Calculating Sub Totals

Sub Totals can be added to a Report at various Levels such as

· Footer
· Group Footer
· Page Footer
· Report Summary

The method by which this achieved is the same in each case with the field appearing in the
relevant Reporting Band that informs the program when to generate and print the Sub Total

To create a Sub-Total field carry out the following steps:-

Create a Text Object and place it in one of the summary bands (Footer, Group Footer, Page
Footer, Report Summary)  The following panel will appear

On the displayed ‘Memo’ panel click on the Σ icon to display the ‘Insert Aggregate’ panel

· Select  the function ‘SUM’ from the drop-down list
· Select the Dataset where the field resides
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· Select the Field that is being ‘Summed’
· Click the ‘OK’ button when done

Click the green ‘tick’ to complete the task

Hint:-   If you know the format of the expression you can simply enter [SUM(<Sales."List Price">)]
directly into the ‘Memo’ Panel.   

4.12 Creating Conditional Highlighting

With this feature you can specify a condition of a field (Example:- Value > 5000, or Invoice Date <
a specified Date) and, depending upon the condition, change the display properties of the field (for
example Bold, Red Text, or Green background to the field).

To add this feature you should:-

        Click on the field where you wish to apply the highlight

  
Select the ‘Conditional Highlighting’ Icon found on the ‘Text’ Toolbar

On the displayed ‘Highlight’ panel click on the fx button and define the condition.

For example:- we may want a Customer List to highlight where the Country is (say) ‘US’

‘Double Click’ on the Country field which will place the selected field in the lower panel.
Define the condition to be satisfied to create the highlight.   In this example

<Customers.”Country”> = ‘US’

Where <Customers.”Country”>  is the field
=   is the condition
‘US’   is the value to be highlighted

Click ‘OK’ to return to the ‘Memo’ panel and define the highlight itself
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Select the Font style and/or the background colour if this condition is satisfied.  Click ‘OK’ to close.

If you run the report then the following printout will be produced with the Country field highlighted
and the text font in selected colour

4.13 Adding Barcodes to the Report

You can print any Text or Database field onto the document as a barcode field as follows:-

 

Select the ‘Other Objects’ icon and choose ‘Barcode Object’ from the drop-down list.  Place the
field into the Band and a Barcode Editor panel will appear.

You may type fixed text into the ‘Code’ field or click on the fx drop-down button to display the data
fields

Double click the field to be displayed in barcode format  than click the ‘OK’ button

Choose the following

§ Type of Bar from the drop-down list
§ If it contains a checksum
§ Print the size
§ Identify its rotation
§ Click ‘OK’ when done

The result should look something like this
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4.14 Adding QRCodes to the Report

You can print any Text or Database field onto the document as a QRCode field as follows:-

Step 1:  Insert a Picture Object

Step 2: Create an OnBeforePrint event (example: Picture1OnBeforePrint )

Step 3: Create the OnBeforePrint procedure in the code section:

Step 4:  Preview the result:
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4.15 Adding Backgrounds to the Report

A background allows you to create an area of background over which you can apply text, etc.  This
can, for example, create White Text over a Blue background as the example below

Create a background.  

 

Select the ‘Draw’ icon then select the shape from the drop-down list and place the cursor on the
main area and click on the left mouse.   The created (blank) shape should be surrounded by 8 dots
(known as ‘handles’).    Select one of the handles to expand or contract the shape.  If you select
the centre of the shape and hold down the left mouse you can move the object around the page

Formatting Options

If you click on the created object then the following options are available to you on the ‘Frame’
Toolbar
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Select the colour to fill the shape

  

Select the colour of the line around the shape

  

Select the style of the line around the shape

  

Select the thickness of the line around the shape

To create the Text simply add a Text Field and select colour ‘White’

4.16 Adding Lines to a Report

 

Select the ‘Line Object’ icon then place the cursor on the main area and click on the left mouse to
define the start position of the line.  You can draw a line in either the vertical or horizontal direction 
You can continue drawing lines until you click on the ‘Select Tool’ Icon   

The created line has two dots (known as ‘handles’).  Select one of the handles to lengthen or
shorten the line.  If you select the centre of the line and hold down the left mouse you can move
the line around the page

Formatting Options

If you click on the created line then the following options are available to you on the ‘Frame’
Toolbar

 

Select the colour of the line
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Select the style of the line

 

Select the thickness of the line 

The following example shows a dotted line that has been included in a Master Data Band.  This will
therefore print out once for each line of data as shown

Diagonal Lines

If you click the right mouse button on the line and select  ‘Diagonal’ from the drop-down list you
can then drag and drop either end of the line and move it to the required position

4.17 Adding a Logo or Picture to the Report

Logos and Photographs are inserted into a report in the same manner.

 

Firstly create a picture field by clicking on the ‘Picture Object’ Icon then place the cursor on the
main area and click on the left mouse.          

A panel will appear in which you can add or change the picture as follows:-
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A panel will appear in which you can add or change the picture as follows:-

To add a Logo then click on the ‘Load’ Icon then locate and select your Logo or picture
Click on the ‘Open’ button to confirm the selection

Size the displayed Logo or Picture to suit by dragging on the object’s ‘handles’

4.18 Creating a Multiple Column Report

You can identify that a Report has a multi-column output by simply clicking on File>Page Settings
and then clicking the ‘Other Options’ tab and defining the number of columns in the page

4.19 Copy an Object or group of Objects

Individual Field Copy

If you wish to copy a single field object there are two ways this can be achieved.

§ Select the field then click the right mouse and select ‘Copy’.  Now click the right mouse
again and select ‘Paste’.

§ Select the field then click the ‘Copy’ Icon on the ‘Standard’ Toolbar followed by the ‘Paste
’ Icon.

In both instances a copy will be attached to the cursor and you can drag this to the desired
position.

Copying multiple Selected Fields

If you wish to copy multiple selected fields then you simply click on each field in turn whilst at the
same time holding down the ‘Shift’ key on the keyboard.   Having selected the fields then:-

§ Click the right mouse and select ‘Copy’.    Now click the right mouse again and select ‘
Paste’, or

§ Click the ‘Copy’ Icon on the ‘Standard’ Toolbar followed by the ‘Paste’ Icon.

In both instances a copy will be attached to the cursor and you can drag this to the desired
position.

Copying all fields in a selected area

If you wish to copy all fields in a selected area then move the mouse to the upper left of the area to
be copied (NOT in a current object or Band) then drag the mouse down and right to create a
rectangle that surrounds the area to be copied.   Now:- 

§ Click the right mouse and select ‘Copy’.  Now click the right mouse again and select ‘
Paste’, or

§ Click the ‘Copy’ Icon on the ‘Standard’ Toolbar followed by the ‘Paste’ Icon.

In both instances a copy will be attached to the cursor and you can drag this to the desired
position.
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Hint - You can select all fields in a selected group then ‘Shift/Click’ on a specific object to de-select
it from the group

4.20 Overlaying Objects

You may lay one object on top of another but you should take into account which object you wish
to be in front and which to be behind.   A good example is where you wish to place text over text to
emulate a shadow. 

Step 1    Create a Text Field on your Report

Step 2    Copy and then Paste - offset from the original

Step 3    Change Text colour of the copy to Grey

Step 4    ‘Right Mouse’ on the Grey Text and select ‘Send to Back’

4.21 Adding a record Count to the Report

This feature allows you to count the number of records contained in a 'Group' or Report.  Your
report should have the following Bands

  - Master Data
  - Group Footer and/or Report Summary

To display the counted records carry out the following steps:-

Step 1.  to the right of the Master Data Band name you will find the Object Identity of the Band 

Step 2.  Insert a Rectangle Object into the 'Group Footer' and/or the ‘Report Summary’ Band



50 Ostendo Reporting Help

Enter  [COUNT(Band4)] into  the Memo panel for that Object.  (Where 'Band4' is the Object
Identity  noted above).  Click the Green ‘Tick’ to confirm   

If you now run the report you see the number of counted records at the end.

Of course a number on its own is meaningless therefore create a Text field ‘Number of Records’
and place this to the left of the Count field

4.22 Select part of a field to be printed

In this example let us select the first eight characters of the Customer’s Name and print this on the
report.

On the Toolbar click on the ‘Text Object’ Icon then move the cursor to the report and place the
displayed rectangle into the lower part of the Master Data Band as shown below

The following panel will appear

Click on the fx icon and then the ‘Functions’ tab.  On this screen scroll down to the ‘String’ section
and double click on Copy(s: String; from, count, Integer): String

You will see Copy( , , ) displayed in the bottom panel

You now need to complete this entry to produce:

Copy(<Customers."Company">,1,6)
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 Where <Customers.”Company”> is the field being referenced
              1 = The character number in the field where the report is to start
              6 = The number of characters - from the start character - to print  

Click the ‘OK’ button to return to the ‘Memo’ screen.  The Memo Screen now shows the selected
field.

Click the green ‘tick’ to return to the main report, which will show the field in the report.   For
example:-

If you now click on the ‘Preview’ Icon you can see the finished listing

4.23 Combining two fields to print as one

In this example let us combine the Contact Name with the Company Name and separate them
with a ‘/’

I.e. Company ‘Action Club’ with Contact ‘Michael Spurling’ would combine and print out as Michael
Spurling / Action Club

On the Toolbar click on the ‘Text Object’ Icon then move the cursor to the report and place the
displayed rectangle into the lower part of the Master Data Band as shown below

The following panel will appear

Click on the fx icon and then the ‘Functions’ tab.  On this screen scroll down to the ‘String’ section
and double click on Trim(s: String): String.  You will see Trim( ) displayed in the bottom panel.

You now need to extend this entry to produce:
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Trim(<Customers."Contact">) + ' / ' + Trim(<Customers."Company">)

 Where Trim tells the program to ignore any trailing spaces not used
             <Customers.”Contact”> is the field being referenced
              + tells the program to append the next set of characters
              ‘ / ‘ inserts a ‘slash’ into the new field to separate the Contact and Customer

 + tells the program to append the next set of characters
Trim tells the program to ignore any trailing spaces not used

              <Customers.”Company”> is the field being referenced

Click the ‘OK’ button to return to the ‘Memo’ screen which shows the following

Click the green ‘tick’ to return to the main report, which will show the field in the report.   For
example:-

If you now click on the ‘Preview’ Icon you can see the finished result

4.24 Creating alternating shaded lines in the Report

Some reports have a print style where each line alternates between shaded and unshaded as
shown in the following example

The shaded background to the line is generated by a single (background) rectangle that lies
behind the text displayed in the line.  This rectangle has a simple rule attached to it to print out
every alternate line.  To create the shaded line carry out the following starting with your standard
report:-

Add a Text object  - don’t add any Text - and place it in the Master Data Band.    Adjust the height
and width to match the size of the band.   
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Whilst you are still focused on the Text Object select View>Toolbars>Object Inspector (or simply
click the F11 key) then carry out the following

· Click on the ‘+’ to the left of ‘Highlight’
· Double Click on the column to the right of ‘Color’ and select the colour of the alternating

band
· In the column to the right of ‘Condition’ enter <Line#> mod 2

If you now run the report you will find that the shaded lines will obscure the print text as follows

Therefore ‘Right Mouse’ on created Text Object and select  ‘Send to Back’ from the dropdown list.
  If you re-run the report it should product the following results

4.25 Printing a Linked Image

If the main record (Example: Item or Descriptor) has a linked Image then, to add this to the report,
you should take the following actions.

Click on the ‘Picture Object’ button    (down the left of the screen) and position it in the relevant
Band then click the Green ‘tick’ symbol.  Resize the Picture and/or Band as required.

For the next step you need to have the ‘Object Inspector’ on your screen.  To display this go to
Views on the top toolbar then select ‘Toolbars’ and then ‘Object Inspector’

-  With the above ‘Picture Object’ selected you will see (on the left) that the field name is Picture1:
TfrxPictureView.   Under that are two tabs.  Select the ‘Properties’ tab and ‘check’ the ‘Stretched’
checkbox and uncheck the ‘Autosize’ checkbox

-  Now select the Band (Example: DetailData1) and you will see (on the left) that the field name is 
DetailData1: TfrxDetailData.   Under that are two tabs.  Select the ‘Events’ tab and double click
on the blank field to the right of ‘OnBeforePrint’.  This will automatically fill it with
DetailData1OnBeforePrint
and also take you to the 'Code' Screen where you should enter the following code.

procedure DetailData1OnBeforePrint(Sender: TfrxComponent);
begin
   if (<DD_1."IMAGEFILE"> <> null) and (trim(<DD_1."IMAGEFILE">) <> '') then
    begin
     DetailData1.visible := True;
     Picture1.loadfromfile(<DD_1."IMAGEFILE">);
    end 
   else
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    begin
      DetailData1.visible := False;
    end;
end.

'Save' the changes then click on the ‘Preview’ Icon on the top Icon Bar you should see the finished
report.

Items without an Image

The Report as it stands will only print those Items that contain an Image.  It is most probable that
you will also want to print those Items that don’t have an Image attached to then.  To achieve this
go into the Report Layout Edit screen and click on the 'MasterData1' Band.  Now refer to the
Object Inspector (Properties) panel.  You will see a field called 'PrintIfDetailEmpty'.  'Check' that
field.

4.26 Print or Hide a Report Band

This is used where you do not wish to print a record if a field within the record has a certain
condition - such as a zero sell Price.   Using the Item Summary Listing Report layout we will
create a condition where if the field [MD_."ONHANDQTY"] held in MasterData Band is found to
be zero then do not print the line.

Step 1.  Click on the Band that contains the field and note the Band ID.  In our case this is (
MasterData1).   

Step 2.  Click on the ‘Events’ tab down the left-hand side and we will now tell the Report Writer
when to carry out the action.   Double-click on the drop-down field to the right of OnBeforePrint. 
This will automatically populate it with MasterData1OnBeforePrint.   and, at the same time, send
you to the 'Code' tab

Step 3.  In the Code tab enter the following:

procedure MasterData1OnBeforePrint(Sender: TfrxComponent);
begin
  if (<MD_."ONHANDQTY"> = 0) then
   begin
     MasterData1.visible := False;                                          
   end           
  else
   begin
     MasterData1.visible := True;                                          
   end;  
end;

If you ‘Save’ the changes and then click the ‘Preview’ button you will find that there are no lines
with zero quantity displayed.

4.27 Print or Hide a Page

This is used where you have multiple report layout options in the same report and wish to select
which page to print depending upon certain criteria
In this example we will use the CRM ‘Call Detail Sheet’ and print a different Call Sheet if the Call
Method was by ‘Phone’.   Copy the Call Detail Sheet to your company Reports folder.
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Step 1.  In the Report Edit view ‘right-mouse’ on the ‘MainPage’ tab and select ‘NewPage’.    A
new tab will appear called ‘Page1’.    Go back to the MainPage tab and - using the drop-down
under ‘Edit’ on the top toolbar - ‘Select  All’ then ‘Copy’.  Click on the ‘Page1’ tab and ‘Paste’.
Position the bands and fields as required.

(If you ‘Save’ the changes and then click the ‘Preview’ button you will find that both pages will be
printed)

Step 2.  Click on the ‘Code’ tab down the left-hand side and copy the following script after the ‘
Begin’ and before the final ‘end.’ statement at the end of the code list.

  if (<MD_."CALLMETHOD"> = 'Phone') then
   begin                   
    MainPage.visible := True;
    Page1.visible := False;
   end            
  else   
   begin                   
    MainPage.visible := False;
    Page1.visible := True;  
   end;

You can see that the above informs the Report Writer that if the Call Method is ‘Phone’ print the
MainPage only, and if not equal to ‘Phone’ print Page1 only

If you ‘Save’ the changes and then click the ‘Preview’ button you will find that the relevant page
will be printed

4.28 Update Ostendo Database

There are instances where you wish to update Ostendo as a result of the Report being run.  For
example: Change the Job Order print status to ‘Printed’.    

Step 1. Go into the Report Layout and click on the main band.  In our example we will assume that
the Job Order header is contained in Band MasterData1.

Step 2.  Click on the ‘Events’ tab down the left-hand side and we will now tell the Report Writer
when to carry out the action.   Click on the drop-down field to the right of OnAfterPrint and ‘
double-click’ the mouse.  This will take you into the ‘Code’ screen where you should enter the
following
.   

procedure MasterData1OnAfterPrint(Sender: TfrxComponent);
var TheOrderNo: string;
begin
   TheOrderNo := <MD_."ORDERNUMBER">;
   UpdateDBValue('JobHeader','PrintStatus','Printed','ORDERNUMBER',TheOrderNo);
end;

‘Save’ the changes.  If you now run the report you will see that the JobHeader table has had field
PrintStatus updated to ‘Printed’
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4.29 Print a Band at the bottom of a page

This enables you to always print a band at the bottom of a page.   However, one thing that you
must take into account is that the normal data can overlap the printing of this Band unless we take
action to prevent this.  In the procedure below we check if there is sufficient remaining space and,
if not, carry out a page break and print this on the following page.  This procedure uses standard
Report Writer variables to determine the free space. 

Step 1. Go into the Report Layout and click on the Band.  In our example we will assume that the
band at the bottom of the page is GroupFooter2.

Step 2.  Click on the ‘Events’ tab down the left-hand side and we will now tell the Report Writer
when to carry out the action.   Click on the drop-down field to the right of OnBeforePrint and ‘
double-click’ the mouse.  This will take you into the ‘Code’ screen where you should enter the
following

procedure GroupFooter2OnBeforePrint(Sender: TfrxComponent);
begin
  if engine.FreeSpace <= GroupFooter2.height then
   begin
    engine.NewPage;
    engine.CurY := engine.PageHeight - GroupFooter2.Height;
   end
  else
   begin
    engine.CurY := engine.PageHeight - GroupFooter2.Height;

   end;

4.30 Restrict Printing to Specific Users

You can restrict who can, and cannot, print a Report by going into the Report Layout and clicking
on the 'Code' tab and entering the following before the final end. statement.   In this example we
are denying User 'ADMIN' from printing this document

Begin
    if uppercase(CurrentUser) = 'ADMIN' then
      Showmessage('You are not allowed to print this document');
      Terminate;
end;



57List Views

5 List Views

‘Views’ in Ostendo provides facility for Users to call up complete sets of data from all major
sections of Ostendo, view and analyses that information, and output to various media.  Whenever
a ‘View’ is run the relevant information is returned from which you can carry out the functions
outlined in this document. 

5.1 Data Analysis Options

The main Analysis screen shows the retrieved information from your database.  The extracted
records can be ‘sliced and diced’ as required

5.1.1 Search and Sort

The following features are available that allow you to sort and filter the displayed data.

§ sort any column in the displayed records into ascending or descending sequence by
clicking on the selected column heading

§ you may ‘filter’ the records based upon your own selection criteria by clicking on the blue
triangular symbol in the selected column heading.  From the drop-down list you may
select the following:-

- All - displays all records
- Blanks - Displays only those records that have no data in the field
- Non-Blanks - Displays only those records that contain data in this field
- Select the specific field content

5.1.2 Moving and Hiding Columns

You may move columns as well as take unwanted columns from the display

§ You can move columns by clicking on the column heading and ‘dragging’ the column into
the required position.    

§ If you double click on the Column Heading’s right edge you can make the column
automatically ‘close up’ to match the amount of data in the field.    You can also achieve
this by ‘Right Clicking’ the column heading and selecting ‘Best Fit’. 

§ If you wish to ‘Close Up’ all the columns then you should ‘Right Click’ on any column
heading and select ‘Best Fit - All Columns’.

If you ‘Right Click’ on a column Heading and select ‘Field Chooser’ then a panel will appear for
storing unwanted columns and enables you to ‘Customise’ the screen.     You can move any
unwanted columns to this panel by simply clicking on the column heading and dragging the column
into this panel.   You can recall stored columns by reversing this procedure.

An alternative to this is to ‘Right Click’ on a column Heading and select ‘Remove this column’.  
This will automatically place the unwanted column in the storage panel

To hide the ‘Field Chooser’ Panel simply click on the ‘x’ in the upper right corner of the panel.

5.1.3 Grouping

You may wish to Group ‘like’ records.  To do this simply drag the required column heading into the
area at the top of the screen where it states ‘Drag a column header here to group by that column’.
(If this area is not visible then you should ‘Right Click’ on any column heading and select ‘Group By
Box’)
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The screen will now group all records where the content of the ‘Grouped’ field is the same. 

§ If you click on the ‘+’ indicator against each Group you can see the detailed records.
§ This Grouping facility is not just single level.   You can Group within Group, etc by simply

dragging and dropping the ‘sub-group’ to the right of the first Group.
§ This can be repeated for as many levels as you require.
§ An alternative method of achieving this is to ‘Right Click’ on the selected column heading

and select ‘Group By This Field’)

5.1.4 Summary Totals

For each Group you may wish to display summary totals.  To do this, expand a Group by clicking
on the‘+’ indicator to display the individual records.  At the bottom of the Group List is a blank area.
If this area is not visible then ‘Right Click’ on a column heading and select ‘Group Footers’. 

Now go to this blank area under any column and ‘right click’ the mouse to display the following
options.  These can be accessed depending upon the type of field (For example, you cannot ‘Sum’
a Date field)

§ Sum Numeric fields only
§ Min Numeric and Date fields only
§ Max Numeric and Date fields only
§ Count All fields
§ Average Numeric fields only
§ None All fields

The selected column will now display the summary information

5.1.5 Grand Totals

You may also wish to display grand totals for the displayed data.  To do this you should see a
blank area at the end of the displayed list.  If this area is not visible then ‘Right Click’ on any
column Heading and select ‘Footer’. 

As with Group Footers, you can go to the blank area under any column and ‘right click’ the mouse
to display the options.  

5.2 Print Options

Whenever you click on the Printer Icon on the top toolbar you have the option to:
· Immediately print the displayed data
· View the ‘report’ from which you may further change the ‘Look and Feel’ prior to finally

sending to the printer.

5.2.1 File Menu

1.  Design

  By clicking on this icon you can define the way the Report is to be presented and has facilities
to address the report’s

View: predefine what can be viewed when printing the document.  The options include:-
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§ A caption created when the View program was generated
§ Column Headings
§ Group and Report Footers
§ Group expansion Buttons
§ Filter information

Behaviors: Defines what data is to be printed such as:-
§ The complete Analysis Screen Data or selected lines
§ Expand Groups upon printing including all Details
§ Automatically size the columns to conform to the data being printed

Formatting: Define how the printed document appears such as:-
§ Flat, Standard, or Ultra Flat appearance
§ Transparent Graphics display
§ Repagination upon change of top level Group
§ Go to new page upon change of Group

Styles: Define Font, Colour, and Texture of Bands, Captions, Headers, Footers, etc

Preview: Define previewing options such as:-
§ Visible Bands
§ Auto Size height
§ Maximum Line Count

Cards: Lets you define the format of the Card view with details such as:-
§ Auto Width or keep same width and height
§ Horizontal and Vertical spacing
§ Borders on the Cards
§ Display Column separator lines and/or record lines
§ Card shadow Colour and depth

Title Properties: By clicking on this button you can enter a Report Title in addition to formatting
the Font, Colour and Alignment of the title on the document

2.  Reloading Saved Reports

  On the displayed panel select the previously saved report (with extension .rps).  If you now
select the ‘Open’ button in that panel the saved report will be displayed.

3.  Unloading Saved Reports

  If you have more than one report open then you can release the current report by selecting
the ‘Unload’ option. You may also enable this option by keying Ctrl-F4.

4.  Save

  This option allows you to save the current report for future recall.  Upon selecting this option
a panel will appear and a new document created prefilled with ‘New Report’  This file name can be
amended if required.

5.  Print
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  This option displays the normal pre-print panel as set up on your PC.  From there you can
print the report.

6.  Page Setup

  This option brings up a screen with 4 panels that allow you to format the page setup of the
report.  The panels are:-

Page: Define paper details such as:-
§ Size (Letter, A4, etc)
§ Orientation (Portrait or Landscape)
§ Source

Margins: Define margins on each page such as:-
§ Left, right, top, bottom
§ Header, Footer
§ Centre Horizontally or Vertically

Header/Footer: Define details for Header and Footer such as:-
§ Font size, Colour, and Background Fill
§ Alignment
§ Insertions (Page Number, Date, Time, etc)
§ Reverse on Even Page selection

Scaling: Defines the number and position of report pages per printed page

7.  Options

The Report Options is selected from the drop-down list under File on the top toolbar. It lets you
define additional Report options that you may wish to use, such as:-

§ Show Margins and Margin Hints
§ Zoom Steps and whether it can be used with IntelliMouse
§ Measurement Units (Inches, Millimetres, or your PC setting)
§ Margin Colours

5.2.2 View Menu

View Options are selected from the drop-down list under View on the top toolbar.  It enables you to
set various switches relating to how the display is presented.  The options are:-

Margins: If this is checked then the report will have its top, bottom and side margins displayed. 
You may also use Ctrl-M to perform this function.

Flat Toolbar Button: If this is checked then the main Toolbar will be displayed in flat format.   If
not checked then it will have ‘shadows’ to each icon

Large Toolbar Button: If this is checked then the main Toolbar will be displayed in a larger
format.

Margins Bar: If this is checked then a bar will appear below the main Toolbar showing the position
and dimensions of the margins.

Status Bar: If this is checked then a document status bar will be displayed at the bottom of the
screen
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Thumbnails: If this is checked then a panel will appear on the right of the screen showing
thumbnails of the current report. If you select a thumbnail then the actual page will be displayed on
the left.

Zoom: If this is checked then you can zoom in on the current document in the following forms:-

§ 100%
§ Page Width
§ Whole Page
§ Two Pages
§ Four Pages
§ Source Width
§ User defined setup

Page Header: If this is checked then the Page Headers will be displayed

Page Footers: If this is checked then the Page Footers will be displayed.

5.2.3 Format Options

Format Options are selected from the drop-down list under Format on the top toolbar.  It enables
you to define the following options prior to printing or saving

Title: You have the option to give the report a title if it does not already have one.  This will appear
at the top of the report.

Date and Time: If the Page Setup has ‘Date and Time Printed’ on the Header or Footer then you
can specify the format of that date and time prior to printing

Page Numbering: If the Page Setup has ‘Page#’ on the Header or Footer then you can specify the
format and start number of the page prior to printing

Fit to Page: If this is selected then all the selected data will be printed on a single page across the
width.  This may cause unreadable printout so you should consider either hiding unwanted fields or
unselecting this option.

Background: If this is selected then a panel will appear for you to select a background colour and
effect.   

5.2.4 Go Dropdown

The ‘Go’ drop-down presents the following options

First Page: Go to first page of the Report

Previous Page: Go to previous page in this Report

Next Page: Go to first page in this Report

Last Page: Go to last page in this Report
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5.3 Email Options

1.   XLS

Generates an XLS (spreadsheet) from the displayed information and then opens up the Emailing
routine on your PC with this XLS document as an attachment

2.   HTML

Generates an HTML format and displays this in the ‘body’ of the generated email

3.   XML

Generates an XML document, which can be called and displayed as a standard Web form.    It
also creates an XSL document showing the source document from the displayed information.  The
program then opens up the Emailing routine on your PC with the XML and XSL documents
attached.

4.   CSV

Generates an CSV (Comma Separated Value) document from the displayed information and then
opens up the Emailing routine on your PC with this CSV document as an attachment

5.4 Exporting

The following options are available for you to export the report. The option can be selected from
the top toolbar

1.   Export to Excel      

  If this is selected then a panel will appear for you to save the current displayed data as an
Excel Spreadsheet.  You may then call up Excel and manipulate the data as required.

2.   Export to HTML    

  If this is selected then a panel will appear for you to save the current displayed data as an
HTML file.  This file can then be called and displayed as a standard Web form using your Browser.

3.   Export to XML   

 If this is selected then a panel will appear for you to save the current displayed data as an
XML file.  Two files are created.    

§ An XML document that can be called and displayed as a standard Web form using your



63List Views

Browser.
§ An XSL document showing the source document 

This file can then be called and displayed as a standard Web form using your Browser.

4.   Export to CSV 

 If this is selected then a panel will appear for you to save the current displayed data as a
Comma Separated Value file. This can be used as an import format to external systems. You may
also call up the CSV file in Excel (File Type = .csv) and manipulate the data as required.

5.  Mail Merge 

 If this is selected then the displayed information will be exported to a .csv file that forms the
basis of generating a Word Document to print out the information in that document.  A separate
tutorial is available that describes how to set up and run this feature
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6 Chart Views

The Charts View enables you to see a pictorial representation of various statistics with option to
drill down, filter, select chart format, etc.

6.1 Main Toolbar

Data Levels:  This shows the drill-down data levels available on each view.  You can either select
the Data Level by clicking on the Level Name.  Alternatively you can ‘left mouse’ on the chart
diagram to drill down one level at a time and ‘right mouse’ to go back up the levels

Selection within Level: If you click on the field to the right of each Level then a drop-down list is
presented showing all the options within that level.  Selecting from the drop-down list will restrict
the display to that option

Customize Chart: Clicking on this button will allow you to customise the presentation.  The
presentation options are:

Series:  Within this panel you can select:
· Select the field(s) to be displayed
· Drag and drop the field to the required appearance order

Data Groups:  Not currently used
Options:  Within this panel you can:

· Define the position of the Chart’s Legend
· Define, within the above selection, where the Legend is to appear
· Define the orientation of the Legend
· Define if the Legend has a border around it
· Define if the Legend ‘key’ has a border around it
· Define the position of the Chart’s Title
· Define, within the above selection, where the Title is to appear
· Define where the Toolbar is to appear
· Define if the Toolbar has a border
· Identify if the Diagram selector is to be visible
· Select if you want ‘hints’ to be visible when curso is moved over the

display

Column Diagram: From the drop-down list select the display format of the Chart.  The options
are:

· Column Diagram
· Bar Diagram
· Line Diagram
· Area Diagram
· Pie Diagram

6.2 Output Options

Print: You can output the current view to your screen prior to printing or print directly to a selected
printer.

Email: The drop-down list provides the following options
XLS - Generates an XLS (spreadsheet) from the displayed information and then opens up
the Emailing routine on your PC with this XLS document as an attachment
HTML - Generates an HTML format and displays this in the ‘body’ of the generated email
XML - Generates an XML document, which can be called and displayed as a standard
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Web form.    It also creates an XSL document showing the source document from the
displayed information.  The program then opens up the Emailing routine on your PC with
the XML and XSL documents attached.
CSV - Generates an CSV (Comma Separated Value) document from the displayed
information and then opens up the Emailing routine on your PC with this CSV document as
an attachment

Export: The drop-down list provides the following options
XLS -  If this is selected then a panel will appear for you to save the current displayed data
as an Excel Spreadsheet.  You may then call up Excel and manipulate the data as
required.
HTML - If this is selected then a panel will appear for you to save the current displayed
data as an HTML file.  This file can then be called and displayed as a standard Web form
using your Browser.
XML - If this is selected then a panel will appear for you to save the current displayed data
as an XML file.  Two files are created.    

· An XML document that can be called and displayed as a standard Web form
using your Browser.

· An XSL document showing the source document 
This file can then be called and displayed as a standard Web form using your
Browser.

CSV - If this is selected then a panel will appear for you to save the current displayed data
as a Comma Separated Value file.  This can be used as an import format to external
systems.     You may also call up the CSV file in Excel (File Type = .csv) and manipulate
the data as required.
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7 Pivot Views

When looking for the tools of analysing data in different ways without any coding, the pivot grid is
the best solution.  With the drag-and-drop functionality, it allows Users to rearrange fields in the
view dynamically.  This includes:

       Interchanging columns and rows on the fly

       Filtering and sorting items in different ways

       Collapsing and expanding data at different levels.

 

The main features of the Pivot Grid include:

 
Automatic summary calculation for each cell – There are 5 summary functions available: Sum,

Count, Min, Max, and Average.
 
Display Multiple data fields – This feature allows you to calculate and display multiple

summaries at the intersection of each column and row.
 
Multiple column and row fields – The values of column and row fields are listed along the top

and right edges of the control and they identify column and row headers. The values of multiple
column (row) fields are arranged into a hierarchy and can be expanded.

 
Automatic Total calculation – Totals display total summaries calculated for outer column and

row fields.
 
Automatic Grand Total calculation – Grand Totals display overall summary totals calculated

against all the columns and rows. They are displayed as the bottom-most rows or right-most
(left-most) columns.

 
Filtering data – This feature enables you to limit which records are processed. A User can easily

change the filter at runtime via the Filter Drop-down.
 
Automatic sorting of column and row field values in alphabetical order (for text data) and in order

of magnitude (for numeric and date/time data). A User can change a field's sort order (from
ascending to descending and vice versa) by clicking the field header.

 
Sorting by summary values – The Pivot Grid control enables column and row field values to be

sorted by total summary values.
 
Customizable position of data field headers.
 
Export – to HTML, XML, XLS and TXT formats.
 
Cell selection and copying to clipboard – A User can select a range of cells with the mouse and

then copy their contents by pressing the CTRL+C shortcut. The selected data is copied to the
clipboard in the tab-separated format that is natively supported by Microsoft Excel, for instance.

 
Dragging fields between different areas – Users can freely drag field headers between different

control areas. This gives them full control when analysing the data.
 
Built-in Customisation Form – Allows Users to temporarily hide fields and make them visible

again.
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7.1 Basic View

A Pivot Grid in Ostendo has four major ‘working’ areas shown in the top of the display

Filter Band: A band across the top of the Grid in which you can display fields and their filtering
options.  If you click on the drop-down contained within each field then you can specify the specific
selection(s) to appear in the Pivot Grid.

Data Area: A small area immediately under the Filter Band in the left part of the screen.  These
show the fields being calculated whose details are displayed in the main Pivot Grid

Column Area: An area immediately under the Filter Band to the right of the Data Area.  If you:
· Click on the drop-down contained within each field name then you can specify the specific

selection(s) of that name to appear in the Pivot Grid.
· Click on the transparent arrow within each field name to sort the columns into ascending

or descending order

Row Area: An area immediately under the Data Area.  If you:
· Click on the drop-down contained within each field name then you can specify the specific

selection(s) of that name to appear in the Pivot Grid.
· Click on the transparent arrow within each field name to sort the rows into ascending or

descending order

7.2 Field Visibility

You can carry out the following activities that enable you to address the visibility of selected fields.

Individual Field visibility options:  If you ‘right mouse on any field in the upper ‘work area’ then
the following options are available

· Hide: Hides the selected field from the display
· Order: Moves the selected field to:

o Move to Beginning
o Move to End
o Move Right
o Move Left

· Hide or Show Field List: Hides or shows a panel in the bottom right of the screen for
hiding and restoring multiple fields.  See next option

Multiple Field visibility options:  If you ‘right mouse outside of any field in the upper ‘work area’
then the following is displayed

· Hide or Show Field List: Hides or shows a panel in the bottom right of the screen for
hiding and restoring multiple fields.  Within this panel you can 
o Drag any shown field onto the Pivot Grid for use in the Grid
o Drag any field from the Pivot Grid to this panel to hide the field

7.3 Expanding, Collapsing, Grouping of Columns and Rows

You can click on the ‘Plus’ or ‘Minus’ buttons shown in the heading of fields to expand and collapse
columns and rows that have nested columns and rows:
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7.4 Filtering

Data can be filtered against column, row and filter fields by clicking the filter button (Black
downward facing triangle seen in the field header) and selecting items in the filter drop-down.

7.5 Field Drill-Down

For any calculated field in the main body of the Pivot Grid you can ‘double click’ on the field to drill
down and display the records that are the source of the displayed summary information.

7.6 Multiple Views

Using the same extraction query you can create multiple Pivot Views.  These can be saved and
recalled using the same extracted data.

To save a View click on the 'Save' button in the top toolbar and enter the name of the View.  Upon
saving the first View two more buttons will appear.  These are:

Restore:  If this is selected then a drop-down list is presented showing all your saved Views. 
Select the View that you want to display

Delete: If this is selected then a drop-down list is presented showing all your saved Views.  Select
the specific View that you want to delete from the list

7.7 Keyboard Shortcuts

The keyboard shortcuts and mouse operations listed in the table below can be used by the User to
move focus between cells.

· Clicking a cell: Focuses the clicked cell.

· Pressing the Up, Down, Left or Right arrow keys: Focuses a corresponding adjacent
cell.

· Pressing the Page Down key: Moves row focus one page down preserving the column
focus.

· Pressing the Page Up key: Moves row focus one page up preserving the column focus.

· Pressing the Home key: Focuses the first cell within the current row.

· Pressing the End key: Focuses the last cell within the current row.

· Pressing the Ctrl+Home key: Focuses the first cell within the first row.

· Pressing the Ctrl+End key: Focuses the last cell within the last row.

7.8 Re-Ordering Fields

The following operations can be performed by Users to rearrange fields:

· Drag a field header and drop it at a new position within the same or another header area.

· Select an option from the "Order" submenu in the field header context menu.

· Double-click a field header within the customisation form or selecting a field header and
clicking the form's Add To button.



69Pivot Views

7.9 Resizing Columns

The following operations can be performed by Users to resize columns:

· Drag the right edge of a column header to change the width of the current and relative
columns.

· If you Double-click the right edge of a column header then it applies best fit to the current
and relative columns

7.10 Selecting Cells

The Pivot Grid control allows Users to select multiple data cells using the mouse or the available
keyboard shortcuts. The data that is displayed by the selected cells can be copied to the clipboard
and pasted into other applications (e.g. MS Excel, MS Word).

Pressing the Shift+Arrow key combination enables Users to select a continuous range of data
cells. When such actions are carried out any previous cell selection is cleared.
Pressing the Ctrl+A key combination will select all data cells within the data area.

7.11 Copying Selected Records to the Clipboard

Pressing the Ctrl+C or Ctrl+Ins key combination will copy the selected data cells to the clipboard
as text.

7.12 Sorting

The values of column fields and row fields are always displayed in ascending or descending order. 
You can alternate between ascending and descending by simply clicking on the field header. 

7.13 Output Options

Print: You can output the current view to your screen prior to printing or print directly to a selected
printer.

Email: The drop-down list provides the following options
XLS - Generates an XLS (spreadsheet) from the displayed information and then opens up
the Emailing routine on your PC with this XLS document as an attachment
HTML - Generates an HTML format and displays this in the ‘body’ of the generated email
XML - Generates an XML document, which can be called and displayed as a standard
Web form.    It also creates an XSL document showing the source document from the
displayed information.  The program then opens up the Emailing routine on your PC with
the XML and XSL documents attached.
CSV - Generates an CSV (Comma Separated Value) document from the displayed
information and then opens up the Emailing routine on your PC with this CSV document as
an attachment

Export: The drop-down list provides the following options
XLS -  If this is selected then a panel will appear for you to save the current displayed data
as an Excel Spreadsheet.  You may then call up Excel and manipulate the data as
required.
HTML - If this is selected then a panel will appear for you to save the current displayed
data as an HTML file.  This file can then be called and displayed as a standard Web form
using your Browser.
XML - If this is selected then a panel will appear for you to save the current displayed data
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as an XML file.  Two files are created.    
· An XML document that can be called and displayed as a standard Web form

using your Browser.
· An XSL document showing the source document 

This file can then be called and displayed as a standard Web form using your
Browser.

CSV - If this is selected then a panel will appear for you to save the current displayed data
as a Comma Separated Value file.  This can be used as an import format to external
systems.     You may also call up the CSV file in Excel (File Type = .csv) and manipulate
the data as required.
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8 Inquiry Screens

‘Inquiries’ in Ostendo’s Report and View Developer provides facility for User to create their own
Inquiry screens from all areas of Ostendo.  Whenever an ‘Inquiry’ is run the relevant information is
returned from which you can carry out the functions outlined below 

The generated Inquiry has two or three screens.
· A ‘List’ screen shows the extracted records using the fields defined in your Master Query.
· A ‘Detail’ screen showing details of a selected record in ‘card’ format and shows the fields

defined in Master Query.
· An additional ‘Lines’ screen showing one or more records linked to the ‘Detail’ record  if

this has been defined in Detailed Query #1 

NOTE:  When creating an Inquiry Screen it is recommended that the Query defines the specific
fields to be extracted.  If you define (for example) Select * from..... then a delay will occur when
generating the screen during daily use

8.1 Search and Sort

The following features are available that allow you to sort and filter the displayed data.

§ sort any column in the displayed records into ascending or descending sequence by
clicking on the selected column heading

§ You may ‘filter’ the records based upon your own selection criteria by clicking on the blue
triangular symbol in the selected column heading.  From the drop-down list you may
select the following:-

- All - displays all records
- Blanks - Displays only those records that have no data in the field
- Non-Blanks - Displays only those records that contain data in this field
- Select the specific field content using the ‘Custom’ option

8.2 Moving and Hiding Columns

You may also move columns as well as take unwanted columns from the display

§ You can move columns by clicking on the column heading and ‘dragging’ the column into
the required position.    

§ If you double click on the Column Heading’s right edge you can make the column
automatically ‘close up’ to match the amount of data in the field.    You can also achieve
this by ‘Right Clicking’ the column heading and selecting ‘Best Fit’. 

§ If you wish to ‘Close Up’ all the columns then you should ‘Right Click’ on any column
heading and select ‘Best Fit - All Columns’.

§ If you ‘Right Click’ on a column Heading and select ‘Field Chooser’ then a panel will
appear for storing unwanted columns and enables you to ‘Customise’ the screen.     You
can move any unwanted columns to this panel by simply clicking on the column heading
and dragging the column into this panel.   You can recall stored columns by reversing this
procedure.
An alternative to this is to ‘Right Click’ on a column Heading and select ‘Remove this
column’.  This will automatically place the unwanted column in the storage panel
To hide the ‘Field Chooser’ Panel simply click on the ‘x’ in the upper right corner of the
panel
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8.3 Grouping

You may wish to Group ‘like’ records.  To do this simply drag the required column heading into the
area at the top of the screen where it states ‘Drag a column header here to group by that column’.
(If this area is not visible then you should ‘Right Click’ on any column heading and select ‘Group By
Box’)

The screen will now group all records where the content of the ‘Grouped’ field is the same. 

§ If you click on the ‘+’ indicator against each Group you can see the detailed records.
§ This Grouping facility is not just single level.   You can Group within Group, etc by simply

dragging and dropping the ‘sub-group’ to the right of the first Group.
§ This can be repeated for as many levels as you require.
§ An alternative method of achieving this is to ‘Right Click’ on the selected column heading

and select ‘Group By This Field’)

8.4 Summary Totals

For each Group you may wish to display summary totals.  To do this, expand a Group by clicking
on the‘+’ indicator to display the individual records.  At the bottom of the Group List is a blank area.
If this area is not visible then ‘Right Click’ on a column heading and select ‘Group Footers’. 

Now go to this blank area under any column and ‘right click’ the mouse to display the following
options.  These can be accessed depending upon the type of field (For example, you cannot ‘Sum’
a Date field)

§ Sum Numeric fields only
§ Min Numeric and Date fields only
§ Max Numeric and Date fields only
§ Count All fields
§ Average Numeric fields only
§ None All fields

The selected column will now display the summary information

8.5 Grand Totals

You may also wish to display grand totals for the displayed data.  To do this you should see a
blank area at the end of the displayed list.  If this area is not visible then ‘Right Click’ on any
column Heading and select ‘Footer’. 

As with Group Footers, you can go to the blank area under any column and ‘right click’ the mouse
to display the options.  
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9 Edit Views

‘Edit Views’ in Ostendo’s Report and View Developer provides facility for User to add, change, and
delete records in their own 'User-Defined' Tables.  This view is normally created when defining the
User-Defined Table(s)  

The generated Inquiry has two or three screens.
· A ‘List’ screen shows the extracted records using the fields defined in your Master Query.
· A ‘Detail’ screen showing details of a selected record in ‘card’ format and shows the fields

defined in Master Query.
· An additional ‘Lines’ screen showing one or more records linked to the ‘Detail’ record  if

this has been defined in Detailed Query #1 

9.1 Search and Sort

The following features are available that allow you to sort and filter the displayed data.

§ sort any column in the displayed records into ascending or descending sequence by
clicking on the selected column heading

§ You may ‘filter’ the records based upon your own selection criteria by clicking on the blue
triangular symbol in the selected column heading.  From the drop-down list you may
select the following:-

- All - displays all records
- Blanks - Displays only those records that have no data in the field
- Non-Blanks - Displays only those records that contain data in this field
- Select the specific field content using the ‘Custom’ option

9.2 Moving and Hiding Columns

You may also move columns as well as take unwanted columns from the display

§ You can move columns by clicking on the column heading and ‘dragging’ the column into
the required position.    

§ If you double click on the Column Heading’s right edge you can make the column
automatically ‘close up’ to match the amount of data in the field.    You can also achieve
this by ‘Right Clicking’ the column heading and selecting ‘Best Fit’. 

§ If you wish to ‘Close Up’ all the columns then you should ‘Right Click’ on any column
heading and select ‘Best Fit - All Columns’.

§ If you ‘Right Click’ on a column Heading and select ‘Field Chooser’ then a panel will
appear for storing unwanted columns and enables you to ‘Customise’ the screen.     You
can move any unwanted columns to this panel by simply clicking on the column heading
and dragging the column into this panel.   You can recall stored columns by reversing this
procedure.
An alternative to this is to ‘Right Click’ on a column Heading and select ‘Remove this
column’.  This will automatically place the unwanted column in the storage panel
To hide the ‘Field Chooser’ Panel simply click on the ‘x’ in the upper right corner of the
panel
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9.3 Grouping

You may wish to Group ‘like’ records.  To do this simply drag the required column heading into the
area at the top of the screen where it states ‘Drag a column header here to group by that column’.
(If this area is not visible then you should ‘Right Click’ on any column heading and select ‘Group By
Box’)

The screen will now group all records where the content of the ‘Grouped’ field is the same. 

§ If you click on the ‘+’ indicator against each Group you can see the detailed records.
§ This Grouping facility is not just single level.   You can Group within Group, etc by simply

dragging and dropping the ‘sub-group’ to the right of the first Group.
§ This can be repeated for as many levels as you require.
§ An alternative method of achieving this is to ‘Right Click’ on the selected column heading

and select ‘Group By This Field’)

9.4 Summary Totals

For each Group you may wish to display summary totals.  To do this, expand a Group by clicking
on the‘+’ indicator to display the individual records.  At the bottom of the Group List is a blank area.
If this area is not visible then ‘Right Click’ on a column heading and select ‘Group Footers’. 

Now go to this blank area under any column and ‘right click’ the mouse to display the following
options.  These can be accessed depending upon the type of field (For example, you cannot ‘Sum’
a Date field)

§ Sum Numeric fields only
§ Min Numeric and Date fields only
§ Max Numeric and Date fields only
§ Count All fields
§ Average Numeric fields only
§ None All fields

The selected column will now display the summary information

9.5 Grand Totals

You may also wish to display grand totals for the displayed data.  To do this you should see a
blank area at the end of the displayed list.  If this area is not visible then ‘Right Click’ on any
column Heading and select ‘Footer’. 

As with Group Footers, you can go to the blank area under any column and ‘right click’ the mouse
to display the options.  
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